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NEW SERIES  新
品

系
列

 新
品

NEW SERIES  新
品

系
列

 新
品

> 2/3 GN Chafer
> Glass Lid
> Electrical

E20102
碟菲餐炉

> Electrical 2/3 GN Chafer
> Glass Lid
> Temperature Control

TCE20102
温控显示碟菲炉

型号 容量 额定功率 额定电压 额定频率

E20102 5.1L 500W 220-240V~ 50/60HZ 配 DB-230 
适用 10A 国际插头

型号 容量 额定功率 额定电压 额定频率

TCE20102 5.1L 500W 220-240V~ 50/60HZ 配 DB-230 
适用 10A 国际插头

> 1/1 GN Chafer
> Glass / Steel Lid
> Electrical

E20104
碟菲餐炉

> Electrical 1/1 GN Chafer
> Glass Lid
> Temperature Control

TCE20104
温控显示碟菲炉

型号 容量 额定功率 额定电压 额定频率

E20104 单 7.6L 
双 3.4L*2 500W 220-240V~ 50/60HZ 配 DB-230 

适用 10A 国际插头

型号 容量 额定功率 额定电压 额定频率

TCE20104 单 7.6L 
双 3.4L*2 500W 220-240V~ 50/60HZ 配 DB-230 

适用 10A 国际插头

> Round 38cm Chafer / Glass Lid
> Electrical

E20101
碟菲餐炉

型号 容量 额定功率 额定电压 额定频率

E20101 6L 500W 220-240V~ 50/60HZ 配 DB-230 
适用 10A 国际插头

> 38cm Round Electrical Chafer
> Glass Lid
> Temperature Control

TCE20101
温控显示碟菲炉

型号 容量 额定功率 额定电压 额定频率

TCE20101 6L 500W 220-240V~ 50/60HZ 配 DB-230
适用 10A 国际插头

2021 NEW PRODUCTS
2021 新品

21305

21301

> Round 38cm / 30cm full area glass 
vision Lid  / induction Chafing dish

> ss insert

21301  /  21305
圆形餐炉 / 大玻璃盖

L385 W475 H165

21306

21302

L375 W430 H165

> Square GN2/3  / GN 1/2 full area glass
vision Lid / induction Chafing dish

> ss insert

21302  /  21306 
方形餐炉 / 大玻璃盖

> Rectangle GN1/1 full area glass
vision Lid / induction Chafing dish

> ss insert

21304
长方形餐炉 / 大玻璃盖

L460 L460

L420 L420

L580 L580W420 W420H230 H230

W400 W400

H230 H230

H230 H230
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NEW SERIES  新
品

系
列

 新
品

NEW SERIES  新
品

系
列

 新
品

HS SERIES（系列）

> Round 38cm Glass Lid Vision 
Induction Chafing dish 

> w/ss insert
> 6L

> Round 38cm Steel Lid Vision 
Induction Chafing dish 

> w/ss insert
> 6L

HS301
中国红圆形餐炉 / 玻璃盖

HS301G
中国红圆形餐炉 / 钢盖

> Square GN2/3  Glass Lid Vision 
Induction Chafing dish 

> w/ss insert
> 5.1L

> Square GN2/3 Steel Lid Vision 
Induction Chafing dish 

> w/ss insert
> 5.1L

HS302
中国红方形餐炉 / 玻璃盖

HS302G
中国红方形餐炉 / 钢盖

> Oblong GN1/1 Glass Lid Vision 
Red color Chafing dish 

> w/ss insert
> 8.3L

> Oblong GN1/1 Steel Lid Vision 
Induction Chafing dish 

> w/ss insert
 > 8.3L

HS304
中国红长方形餐炉 / 玻璃盖

HS304G
中国红长形餐炉 / 钢盖

采用杜邦公司高科技材料，
独创制作工艺，可视窗防雾化，防油腻。

采用先进的高温烤漆技术，
经受得住 200 摄氏度的高温考验。

Special show window, use the Dupont's hightec 
material. Original creation making craft, no 
steam and greasy stain.

高科技材料
HIGH-TECH MATERIALS

高温烤漆技术
BAKING VANISH TECHNOLOGY

Using Advanced High Temperature 
Painting Technology, Can withstand the 
test of 200 degrees Celsius

NEW CHINESE RED
全新中国红
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NEW SERIES  新
品
系
列

NEW SERIES  新
品
系
列

J
系

列

J
系

列

型号 容量 额定功率 额定电压 额定频率
J801 6L 500W 22 0-240V~ 50/60HZ 配 DB-500

适用 10A 国际插头J801G 6L 500W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J805 3.8L 350W 220-240V~ 50/60HZ 配 DB-350

适用 10A 国际插头J805G 3.8L 350W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J803 12L 350W 220-240V~ 50/60HZ 配 DB-350RJ

适用 10A 国际插头J803G 12L 350W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J901 6L 500W 220-240V~ 50/60HZ 配 DB-500

适用 10A 国际插头J901G 6L 500W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J802 5.1L 500W 220-240V~ 50/60HZ 配 DB-500

适用 10A 国际插头J802G 5.1L 500W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J806 3.8L 350W 220-240V~ 50/60HZ 配 DB-350

适用 10A 国际插头J806G 3.8L 350W 220-240V~ 50/60HZ

> Round 38cm Glass Lid Vision 
induction Chafing Dish 

> w/ss insert

> Round 30cm Glass Lid Vision
induction Chafing Dish

> w/ss insert

> Round Glass Lid 
induction Soup station

> w/ss insert

> Round 38cm Glass Lid Vision
induction Chafing Dish 

> w/ss insert with electric heater

> Square GN1/2 Glass Lid Vision
induction Chafing Dish

> w/ss insert

> Round 38cm Steel Lid Vision 
induction Chafing Dish 

> w/ss insert

> Round 30cm Steel Lid Vision 
induction Chafing Dish

> w/ss insert

> Round Steel Lid
induction Soup station

> w/ss insert

> Round 38cm Steel Lid Vision 
induction Chafing Dish 

> w/ss insert with electric heater

> Square GN2/3 Steel Lid Vision 
induction Chafing Dish W

> w/ss insert

> Square GN1/2 Steel Lid Vision 
induction Chafing Dish

> w/ss insert

J801 J805

J803 J901

J802 J806

J801G J805G

J803G J901G

J802G J806G

圆形餐炉 / 玻璃盖 圆形餐炉 / 玻璃盖

圆形汤炉 / 玻璃盖 圆形餐炉 / 玻璃盖

方形餐炉 / 玻璃盖 方形餐炉 / 玻璃盖

圆形餐炉 / 钢盖 圆形餐炉 / 钢盖

圆形汤炉 / 钢盖 圆形餐炉 / 钢盖

方形餐炉 / 钢盖 方形餐炉 / 钢盖

J SERIES J SERIES（系列） （系列）
标配酒精炉可选配电热板 标配酒精炉可选配电热板

型号 容量 额定功率 额定电压 额定频率
J804 8.3L 500W 220-240V~ 50/60HZ 配 DB-500

适用 10A 国际插头J804G 8.3L 500W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J902 5.1L 500W 220-240V~ 50/60HZ 配 DB-500

适用 10A 国际插头J902G 5.1L 500W 220-240V~ 50/60HZ

> Square GN2/3 Glass Lid Vision
induction Chafing Dish 

> w/ss insert with electric heater

> Oblong GN1/1  Steel Lid Vision 
induction Chafing Dish 

> w/ss insert

> Square GN2/3 Steel Lid Vision 
induction Chafing Dish

> w/ss insert with electric heater

J804 J902J804G J902G
长方形餐炉 / 玻璃盖 方形餐炉 / 玻璃盖长方形餐炉 / 钢盖 方形餐炉 / 钢盖

> Square GN2/3  Glass Lid Vision 
induction Chafing Dish W

> w/ss insert

> Oblong GN1/1 Glass Lid Vision
induction Chafing Dish 

> w/ss insert
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NEW SERIES  新
品
系
列

NEW SERIES  新
品
系
列

J
系

列

J
系

列

J SERIES J SERIES（系列） （系列）
仅适用电热板 仅适用电热板

型号 容量 额定功率 额定电压 额定频率
J903 12L 350W 220-240V~ 50/60HZ 配 DB-350RJ

适用 10A 国际插头J903G 12L 350W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J1001 6L 500W 220-240V~ 50/60HZ 配 DB-500

适用 10A 国际插头J1001G 6L 500W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J904 8.3L 500W 220-240V~ 50/60HZ 配 DB-500

适用 10A 国际插头J904G 8.3L 500W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J905 3.8L 350W 220-240V~ 50/60HZ 配 DB-350

适用 10A 国际插头J905G 3.8L 350W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J1002 5.1L 500W 220-240V~ 50/60HZ 配 DB-500

适用 10A 国际插头J1002G 5.1L 500W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J1003 12L 350W 220-240V~ 50/60HZ 配 DB-500

适用 10A 国际插头J1003G 12L 350W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J1004 8.3L 500W 220-240V~ 50/60HZ 配 DB-500

适用 10A 国际插头J1004G 8.3L 500W 220-240V~ 50/60HZ

> Round Glass Lid induction 
Soup station

> w/ss insert with electric heater

> Round 38cm Glass Lid Vision
induction Chafing Dish 

> w/ss insert with electric heater

> Round 30cm Glass Lid Vision
induction Chafing Dish 

> w/ss insert with electric heater

> Round 30cm Steel Lid Vision
induction Chafing Dish 

> w/ss insert with electric heater

> Oblong GN1/1 Glass Lid Vision
induction Chafing Dish

> w/ss insert with electric heater

> Square GN2/3 Glass Lid Vision 
induction Chafing Dish 

> w/ss insert with electric heater

> Round Glass Lid induction 
Soup Station

> w/ss insert with electric heater

> Oblong GN1/1 Glass Lid Vision 
induction Chafing Dish 

> w/ss insert with electric heater

> Round Steel Lid induction 
Soup station

> w/ss insert with electric heater

> Round 38 cm Steel Lid Vision
induction Chafing Dish 

> w/ss insert with electric heater

> Oblong GN1/1 Steel Lid Vision
induction Chafing Dish

> w/ss insert with electric heater

> Square GN2/3 Steel Lid Vision 
induction Chafing Dish 

> w/ss insert with electric heater

> Square Steel Lid Vision
induction soup station

> ss insert with electric heater

J903 J1001

J905 J905G

J904 J1002

J1003

J1004

J903G J1001G

J904G J1002G

J1003G

J1004G

圆形汤炉 / 玻璃盖 圆形餐炉 / 玻璃盖

圆形餐炉 / 玻璃盖 圆形餐炉 / 钢盖

长方形餐炉 / 玻璃盖 方形餐炉 / 玻璃盖

圆形汤炉 / 玻璃盖

长方形餐炉 / 玻璃盖

圆形汤炉 / 钢盖 圆形餐炉 / 钢盖

长方形餐炉 / 钢盖 方形餐炉 / 钢盖

圆形汤炉 / 钢盖

长方形餐炉 / 钢盖

型号 容量 额定功率 额定电压 额定频率
J906 3.8L 350W 220-240V~ 50/60HZ 配 DB-350RJ

适用 10A 国际插头J906G 3.8L 350W 220-240V~ 50/60HZ

> Square GN1/2 Glass Lid Vision
induction Chafing Dish 

> w/ss insert with electric heater

J906 J906G
方正餐炉 / 玻璃盖 正餐炉 / 钢盖

> Square GN1/2 Steel Lid Vision
induction Chafing Dish 

> w/ss insert with electric heater

> Oblong GN1/1 Steel Lid Vision
induction Chafing Dish 

> w/ss insert with electric heater
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NEW SERIES  新
品
系
列

NEW SERIES  新
品
系
列

C
系

列

J/C
系

列

J/C SERIES C SERIES（系列） （系列）
仅适用电热板

> Stand for Square GN2/3 Chafing dish > Stand for Round 38cm Chafing dish

C19100G C1980D
碟菲餐炉底座（高框） 碟菲餐炉底座（低框）

型号 容量 额定功率 额定电压 额定频率
J1005 3.8L 350W 220-240V~ 50/60HZ 配 DB-350

适用 10A 国际插头J1005G 3.8L 350W 220-240V~ 50/60HZ

> Round 30cm Glass Lid Vision 
induction Chafing Dish W

> ss insert with electric heater

> Round 30cm Steel Lid Vision 
induction Chafing Dish 

> ss insert with electric heater

J1005 J1005G
电热碟菲餐炉 电热碟菲餐炉 ( 钢盖 )

型号 容量 额定功率 额定电压 额定频率
J1006 3.8L 350W 220-240V~ 50/60HZ 配 DB-350

适用 10A 国际插头J1006G 3.8L 350W 220-240V~ 50/60HZ

> Square GN1/2 Glass Lid Vision
induction Chafing Dish 

> ss insert with electric heater

> Square GN1/2 Steel Lid Vision 
induction Chafing Dish 

> ss insert with electric heater

J1006 J1006G
电热碟菲餐炉 电热碟菲餐炉 ( 钢盖 )

> Stand for Round 38cm Chafing dish

C1980G C1990G
电热碟菲餐炉 电热碟菲餐炉 ( 钢盖 )

> Stand for Oblong GN1/1 Chafing dish > Stand for Oblong 30cm 
Chafing dish

C19104G C1970G
碟菲餐炉底座（高框） 碟菲餐炉底座（高框）

> Stand for Square GN1/2 Chafing dish > Stand for Oblong GN1/1 Chafing dish

C1990D C19104D
碟菲餐炉底座（低框） 碟菲餐炉底座（低框）

> Stand for Round 30cm
Chafing dish

C1970D C19100D
碟菲餐炉底座（低框） 碟菲餐炉底座（低框）

> Stand for Square GN2/3
Chafing dish

> Stand for Round 38cm Chafing dish

C1980 C1990
碟菲餐炉底座 碟菲餐炉底座

> Stand for Square GN1/2 
Chafing dish

> Stand for Square GN1/2 
Chafing dish
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NEW SERIES  新
品
系
列

NEW SERIES  新
品
系
列

C
系

列

C
系

列

C SERIES（系列）

> Stand for Rectangular GN1/1 
Chafing dish

> Stand for Round 30cm 
Chafing dish

C19104 C1970
碟菲餐炉底座 碟菲餐炉底座

> Stand for Square GN2/3 
Chafing dish

C19100
碟菲餐炉底座

复底系列
让您享受到不一样的温度
最新研发 复底餐炉系列
采用 304 不锈钢，铝材，不锈铁三种材质
的有效组合，导热更快速，更均匀。

> Round Glass Lid Vision 
Induction Soup Station

> ss insert
> Capacity       12L 

> Round Glass Lid Vision
Induction Soup Station

> ss insert
> Capacity       12L

J19303 J19303G
多层底圆形汤炉 / 玻璃盖 多层底圆形汤炉 / 钢盖

> Round 38cm Glass Lid Vision 
induction Chafing dish

> ss insert

J19301 J19301G
多层底圆形餐炉 / 玻璃盖 多层底餐炉 / 钢盖

J SERIES （系列）
 电磁炉专用

> Square GN2/3 Glass Lid Vision 
induction Chafing dish

> ss insert

> Square GN2/3 Steel Lid Vision 
induction Chafing dish

> ss insert

J19302 J19302G
多层底方形餐炉 / 玻璃盖 多层底方形餐炉 / 钢盖

J19304 J19304G
多层底长方形餐炉 / 玻璃盖 多层底长方形餐炉 / 钢盖

> Round 30cm  Steel Lid Vision 
induction Chafing dish

> ss insert

J19305 J19305G
多层底圆形餐炉 / 玻璃盖 多层底圆形餐炉 / 钢盖

> Square GN1/2 Glass Lid Vision 
induction Chafing dish

> ss insert

> Square GN1/2  Steel Lid Vision 
induction Chafing dish

> ss insert

J19306 J19306G
多层底方形餐炉 / 玻璃盖 多层底方形餐炉 / 钢盖

> Round 38cm Steel Lid Vision 
induction Chafing dish

> ss insert

> Oblong GN1/1  Glass Lid Vision 
induction Chafing dish

> ss insert

> Oblong GN1/1  Steel Lid Vision 
induction Chafing dish

> ss insert

> Round 30cm Glass Lid Vision 
induction Chafing dish

> ss insert
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NEW SERIES  新
品
系
列

NEW SERIES  新
品
系
列

SAUCE CHAFING DISH 系
列

CHAFING DISH 系
列

CHAFING DISH SERIES SAUCE CHAFING DISH SERIES（系列） （汤汁炉系列）

> Simple rectangular 
chafing dish

> stackable

> Sauce pot
> 3.5L

> Sauce pot
> 3.5L

> Sauce Station
> 4.5L

> Sauce Station
> 4.5L

> Simple round chafing 
dish

> stackable

> Sauce pot
> 7.5L

> Sauce pot
> 7.5L

> Sauce Station
> 10L

> Sauce Station
> 10L

> Simple round chafing 
dish

> stackable

2585-6E 19001

19001-T3.5

T3.5

T4.5

T7.5

T10

19003-4.5

19003-T4.5

2586-30E 19002

19002-T7.5

19003-10

19003-T10

2586-40E

长方形简易餐炉 小餐炉

汤汁炉

汤汁炉

汤汁炉

圆形简易餐炉 小餐炉

汤汁炉

汤汁炉

汤汁炉

圆形简易餐炉

型号 容量 额定功率 额定电压 额定频率
2585-6E 8.3L 380W 220-240V~ 50/60HZ

适用 DB-380 专用电热板
适用 10A 国际插头2586-30E 4.2L 380W 220-240V~ 50/60HZ

2586-40E 7.2L 380W 220-240V~ 50/60HZ

标配酒精炉可配电热板

设计师采用巧妙的构思，化散为整，便
于收纳，既节约储藏空间，又不影响餐
炉本身的功能和形状美观，收取自如！

Stylist uses clever conception, 
change come loose for whole, 
facilitate receive, save storage 
space already, do not affect the 
function of furnace itself and 
shape again beautiful, collect 
freely!
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NEW SERIES  新
品
系
列

NEW SERIES  新
品
系
列

自
动

煮
面

机

自
动

煮
面

机

额定功率 额定电压 额定频率

400W 220-240V~ 50/60HZ 每分钟 1400 转
适用 10A 国际插头

温度设置范围 恒温精度 加热功率 额定电压
0-300° C ±5° C 1500W+3000W 220V

高性能自动恒温控器——性能安全更稳定
304 不锈钢打造——美观更坚固耐用
温控旋钮调节——简便更精准
两组加热装置，单独的温度控制——省时省电更高效
两个炉单独控制

> Automatic Electric Noodle Boiler with Cabinet

ZM1206
自动煮面机

> Multipurpose Electric  Griddle with Cabinet

ZJ1530

GW-04

多用途煎炉

洗杯机

> Sous Vide-Immersion 
Circulator,Head,Water 
basin 3/4 size, and cover

> Glass Washer
> 340*205*455

> Sous Vide-Immersion 
Circulator,Head,Water 
basin 1/1 size, and cover

SV6088-43 SV6088-11
低温烹饪机配 3/4 槽 低温烹饪机配 1/1 槽

型号 额定功率 额定电压 额定频率
SV6088-43 1200W 220-240V 50/60HZ  适用 10A 国际插头
SV6088-11 1200W 220-240V 50/60HZ  适用 10A 国际插头

计算机单片智能核心——性能更稳定
304 不锈钢打造——美观更坚固耐用
全新全自动进排水，恒温设计——轻松更便捷
缺水制动保护系统——安全更放心
2 组 6000W 不锈钢电热管——省时更高效
温度设置范围：0-100° C
额定电压：380V

Computer monolithic intelligent core 
—More stable performance

304 stainless steel
—Beautiful and durable

New automatic inlet and drain, 
constant temperature design
—Easy and convenient

Water brake protection system 
—More secure

2 sets of 6000W stainless steel electric heating pipe
—Time saving and more efficient

Intelligent temperature control
Allow you to adjust the water temperature between 
16 and 93 degrees freely
Quick freezing
Let you save time at the same time to ensure the 
loss of food ingredients
Constant temperature keeping
Completely free up your operation time
Multimode selection
Let you enjoy the fun of low temperature cooking

KINGO LOW TEMPERATURE COOKING 
MACHINE DESIGN,ACCURATE WATER 
TEMPERATURE CONTROL FOR CLOSED 
LOOP CIRCULATION,THE DEVICE 
IS DESIGNED FOR COMMERCIAL 
SERVICE ENTERPRISE INDOOR USE, 
FOR DOMESTIC, INDUSTRIAL OR 
EXPERIMENTAL USE

High performance automatic thermostat
—safe and stable performance

304 stainless steel
—beautiful and durable

Temperature control knob adjustment
—simple and more accurate

Two sets of heating devices, separate 
temperature control
—save time, save electricity and more efficient

智能调温
让您在 16-93 度间自由调节水温
快速解冻
让您在省时同时保证食物成分不流失
恒温保持
完全解放您的操作时间
多模式选择
让您享受对低温烹饪的乐趣

温馨提示：解冻、低温慢煮食品均需真空包装或独立单体
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NEW SERIES  新
品
系
列

NEW SERIES  新
品
系
列

真
空

包
装

机
系

列

烹
饪

机
系

列

本机主要使用于复合薄膜和铝箔复合膜等软包装材料的封口包
装可对固体、液体、粉状、糊状等性质物理进行真空包装

> Sous Vide-Immersion 
Circulator,(Head Only)

> Sous Vide-Immersion 
Circulator,(Head Only)

SV5088 SV6088
低温烹饪机 低温烹饪机

型号 额定功率 额定电压 额定频率
SV5088 1200W 220-240V~ 50/60HZ 适用 10A 国际插头
SV6088 1200W 220-240V~ 50/60HZ 适用 10A 国际插头

> Vacuum Machine

> Vacuum Machine

> Vacuum Machine

> Vacuum Machine

KI280

KI250C

KI400E

KI300T

食品真空包装机

食品真空包装机

食品真空包装机

食品真空包装机

型号 额定功率 额定电压 额定频率
KI280 400W 220-240V~ 50/60HZ 适用 10A 国际插头
KI400E 400W 220-240V~ 50/60HZ 适用 10A 国际插头
KI250C 400W 220-240V~ 50/60HZ 适用 10A 国际插头
KI300T 400W 220-240V~ 50/60HZ 适用 10A 国际插头

KINGO LOW TEMPERATURE COOKING MACHINE 
DESIGN,ACCURATE WATER TEMPERATURE 
CONTROL FOR CLOSED LOOP CIRCULATION,THE 
DEVICE IS DESIGNED FOR COMMERCIAL SERVICE 
ENTERPRISE INDOOR USE, FOR DOMESTIC, 
INDUSTRIAL OR EXPERIMENTAL USE

Intelligent temperature control
Allow you to adjust the water temperature between 16 and 93 
degrees freely

Quick freezing
Let you save time at the same time to ensure the loss of food 
ingredients

Constant temperature keeping
Completely free up your operation time

Multimode selection
Let you enjoy the fun of low temperature cooking

Try out strong
Suitable for various types of POTS and pans

This machine is mainly used for sealing flexible 
packaging materials such as composite film and 
aluminum foil composite film. It can pack solid, 
liquid, powder, paste and other properties in 
vacuum

智能调温
让您在 16-93 度间自由调节水温
快速解冻
让您在省时同时保证食物成分不流失
恒温保持
完全解放您的操作时间
多模式选择
让您享受对低温烹饪的乐趣
试用性强
适合多种类型的盆、锅使用

FOOD VACUUM MACHINE
食品真空包装机系列
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我们生产的不止是容器
更是品质餐饮的氛围缔造者

CREATOR OF THE ATMOSPHERE
MAKER

CHAFING DISH
餐炉类



23 | Achieve every quality dining experience Achieve every quality dining experience | 24

CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

冷
热

可
切

换
餐

炉

冷
热

可
切

换
餐

炉

行业之先锐，实现加热和制冷之间相互切换，诠释
餐炉新概念。

温度可在 -2° C~85° C 自由调控，冰热世界，
在于掌控这间。

Cold and Hot food love this Chafing Dish Temperature at -2°C(36°F)-85°C(185°F) for  freely control.

CH204

COLD HOT

CH204M
冷热可切换餐炉 冷热可切换餐炉

型号 额定功率 额定电压
CH204 320W 220-240V~ 适用 10A 国际插头

型号 额定功率 额定电压
CH204M( 手动 ) 320W 220-240V~ 适用 10A 国际插头
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CHAFING DISH  餐
炉

类
 调

温
TC-S

系
列

CHAFING DISH  餐
炉

类
 调

温
TC-S

系
列

TCS24 SERIES

NEW TC TEMPERATURE REGULATION SERIES FOR 
SOUP AND MEAL STOVES

Humanized design, environmental protection and energy saving 
The temperature can be adjusted between 40 ℃ and 85 ℃ to keep 
the food delicious and fresh 
The original soup stove and meal stove products can be added 
with temperature control function, and the product model with 
temperature control function is to add "Tc -" before the prototype 
number. 
For example, the original product model is "s2403", and the product 
model with temperature control function is "tc-s2403".

型号 容量 额定功率 额定电压 额定频率
TCS2401-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS2401-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS2402-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS2402-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

TCS2401-1 / TCS2401-2 TCS2402-1 / TCS2402-2

> Oblong Chafing Dish 
> Gilt / Chrome Legs

> Show Window
> Temperature Control

TCS2401-1  /  TCS2401-2
TCS2402-1  /  TCS2402-2
温控可视镀金 / 铬长方型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
TCS2403 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS2404 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

TCS2403 TCS2404

> Round Chafing Dish 
> Gilt / Chrome Legs

> Show Window
> Temperature Control

TCS2403  /  TCS2404
温控可视镀金 / 铬球型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
TCS2405 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS2406 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> Gilt / Chrome Legs
> Show Window

TCS2405 TCS2406

> Temperature Control

TCS2405  /  TCS2406
温控可视镀金 / 铬长方型宴会汤炉

型号 容量 额定功率 额定电压 额定频率
TCS2407 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS2408 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Soup Station 
> Gilt / Chrome Legs

TCS2407 TCS2408

> Show Window
> Temperature Control

TCS2407  /  TCS2408
温控可视镀金 / 铬球型宴会汤炉

（系列）

NEW TC SERIES
全新 TC 调温系列

全线汤炉、餐炉产品新增 TC 调温系列
人性化设计，环保节能
温度可按需在 40℃ ~85℃之间随意调节，
保持食品的美味和新鲜
原汤炉、餐炉产品都可增加调温功能，增加温控功能的产品型号
为在原型号前添加“TC-”。
例如：原产品型号为“S2403”，增加温控功能的产品型号为
“TC-S2403”。
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CHAFING DISH  餐
炉

类
 调

温
TC-S

系
列

CHAFING DISH  餐
炉

类
 调

温
TC-S

系
列

TCS68 SERIES TCS67 SERIES

型号 容量 额定功率 额定电压 额定频率
TCS6801-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6801-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6801G-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6801G-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

TCS6801-1 / TCS6801-2 TCS6801G-1 / TCS6801G-2

> Round Chafing Dish 
> Gilt / Chrome Legs

型号 容量 额定功率 额定电压 额定频率
TCS6803 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6803G 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

TCS6803 TCS6803G

> Show Window
> Temperature Control

TCS6803  /  TCS6803G
温控可视镀金 / 铬球型宴会餐炉

TCS6805 TCS6805G

型号 容量 额定功率 额定电压 额定频率
TCS6805 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6805G 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> Gilt / Chrome Legs

> Show Window
> Temperature Control

型号 容量 额定功率 额定电压 额定频率
TCS6807 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6807G 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Soup Station 
> Gilt / Chrome Legs

TCS6807 TCS6807G

> Show Window
> Temperature Control

型号 容量 额定功率 额定电压 额定频率
TCS6705 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6705G 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> Gilt / Chrome Legs

TCS6705 TCS6705G

> Show Window
> Temperature Control

温控可视镀金 / 铬长方型宴会汤炉
TCS6805  /  TCS6805G

温控可视镀金 / 铬长方型宴会汤炉
TCS6705 / TCS6705G

> Round Chafing Dish 
> Gilt / Chrome Legs

型号 容量 额定功率 额定电压 额定频率
TCS6703 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6703G 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

TCS6703 TCS6703G

> Show Window
> Temperature Control

TCS6703 / TCS6703G
温控可视镀金 / 铬球型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
TCS6701-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6701-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6701G-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6701G-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

TCS6701-1 / TCS6701-2 TCS6701G-1 / TCS6701G-2

> Oblong Chafing Dish 
> Gilt / Chrome Legs

> Show Window
> Temperature Control

> Oblong Chafing Dish 
> Gilt / Chrome Legs

> Show Window
> Temperature Control

TCS6801-1  /  TCS6801-2
TCS6801G-1  /  TCS6801G-2
温控可视镀金 / 铬长方型宴会餐炉

TCS6701-1  /  TCS6701-2
TCS6701G-1  /  TCS6701G-2
温控可视镀金 / 铬长方型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
TCS6707 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6707G 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Soup Station 
> Gilt / Chrome Legs

TCS6707 TCS6707G

> Show Window
> Temperature Control

温控可视镀金 / 铬球型宴会汤炉
TCS6807 / TCS6807G

温控可视镀金 / 铬球型宴会汤炉
TCS6707 / TCS6707G

（系列） （系列）
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CHAFING DISH  餐
炉

类
 调

温
TC-S

系
列

CHAFING DISH  餐
炉

类
调

温
TC-B 系

列

型号 容量 额定功率 额定电压 额定频率
TCS6702-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6702-2（双格 Double）  4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6501-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6501-2（双格 Double）  4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Chafing Dish 
> s.s Legs

TCS6702-1 / TCS6702-2 TCS6501-1 / TCS6501-2

> Show Window
> Temperature Control

TCS6702-1  /  TCS6702-2
TCS6501-1  /  TCS6501-2
温控可视全钢长方型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
TCB2401-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB2401-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB2402-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB2402-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Chafing Dish 
> gilt/chorme Legs

TCB2401-1/TCB2401-2 TCB2402-1/TCB2402-2

> Temperature Control

TCB2401-1 / TCB2401-2
TCB2402-1 / TCB2402-2
温控镀金 / 镀铬长方型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
TCS6706 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6505 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> s.s Legs

温控可视全钢长方型宴会汤炉

TCS6706 TCS6505

> Show Window
> Temperature Control

TCS6706 / TCS6505

型号 容量 额定功率 额定电压 额定频率
TCB2405 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB2406 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> gilt/chorme Legs

温控可视镀金 / 镀铬长方型宴会汤炉

TCB2405

> Temperature Control

TCB2405 / TCB2406

> Round Chafing Dish 
> s.s Legs

温控可视全钢球型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
TCS6704 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6503 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

TCS6704 TCS6503

> Show Window
> Temperature Control

TCS6704 / TCS6503

> Round Chafing Dish 
> gilt/chorme Legs

温控镀金 / 镀铬球型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
TCB2403 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB2404 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

TCB2403 TCB2404

> Temperature Control

TCB2403 / TCB2404

型号 容量 额定功率 额定电压 额定频率
TCS6708 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6507 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Soup Station 
> s.s Legs

温控可视全钢球型宴会汤炉

TCS6708 TCS6507

> Show Window
> Temperature Control

TCS6708 / TCS6507

型号 容量 额定功率 额定电压 额定频率
TCB2407 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB2408 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Soup Station 
> Gilt / Chrome Legs

温控可视镀金 / 镀铬球型宴会汤炉

TCB2407 TCB2408

> Temperature Control

TCB2407 / TCB2408

TCB24 SERIESTCS67/65 SERIES （系列）（系列）

TCB2406
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

调
温

TC-B 系
列

调
温

TC-B 系
列

TCB68 SERIES TCB67 SERIES（系列） （系列）

TCB6803 TCB6703TCB6803G TCB6703G

> Round Chafing Dish 
> Gilt / Chrome Legs

型号 容量 额定功率 额定电压 额定频率
TCB6803 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6803G 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

型号 容量 额定功率 额定电压 额定频率
TCB6703 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6703G 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

TCB6803 / TCB6803G
温控镀金全翻盖球形宴会餐炉

TCB6807 TCB6707TCB6807G TCB6707G

> Round Chafing Dish 
> Gilt / Chrome Legs

型号 容量 额定功率 额定电压 额定频率
TCB6807 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6807G 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

型号 容量 额定功率 额定电压 额定频率
TCB6707 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6707G 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

TCB6807  /  TCB6807G
温控镀金 / 铬全翻盖球形宴会汤炉

> Round Chafing Dish 
> Gilt / Chrome Legs

TCB6703  /  TCB6703G
温控镀金全翻盖球形宴会餐炉

> Oblong Soup Station 
> Gilt / Chrome Legs

TCB6705  /  TCB6705G
温控镀金全翻盖双头宴会汤炉

> Round Soup Station 
> Gilt Legs

TCB6707  /  TCB6707G
温控镀金全翻盖球形宴会汤炉

型号 容量 额定功率 额定电压 额定频率
TCB6801-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6801-2（双格 Double）  4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6801G-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6801G-2（双格 Double）  4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

型号 容量 额定功率 额定电压 额定频率
TCB6701-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6701-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6701G-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6701G-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Chafing Dish
> Gilt / Chrome Legs

> Oblong Chafing Dish
> Gilt / Chrome Legs

TCB6801-1/TCB6801-2 TCB6701-1/TCB6701-2TCB6801G-1/TCB6801G-2 TCB6701G-1/TCB6701G-2

> Temperature Control > Temperature Control

TCB6801-1 / TCB6801-2
TCB6801G-1 / TCB6801G-2

TCB6701-1 / TCB6701-2
TCB6701G-1 / TCB6701G-2

温控可视全钢长方型宴会餐炉 温控镀金 / 镀铬长方型宴会餐炉

> Temperature Control

型号 容量 额定功率 额定电压 额定频率
TCB6805 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6805G 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

型号 容量 额定功率 额定电压 额定频率
TCB6705 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6705G 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> Gilt / Chrome Legs

温控可视全钢长方型宴会汤炉

TCB6805 TCB6705TCB6805G TCB6705G

> Temperature Control

TCB6805 / TCB6805G

> Temperature Control

> Temperature Control

> Temperature Control

> Temperature Control
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CHAFING DISH  餐
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类

CHAFING DISH  餐
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类

触
动

M
 系

列

调
温

TC-B 系
列

使用者可轻触控制面板的“OPEN”和“CLOSE”按钮，
可将翻盖调至半翻，全翻和闭合状态。
控制面板的中间部分内藏感应器，使用者取物离开数秒后会自动恢复合盖状态。
翻盖在 关闭过程中会自动感应是否需要恢复半翻盖状态。人性化设计，环保节能，
安全卫生。 
已做安全抗疲劳，超强度运作测试，优于传统装置。
设有温控功能装置，温度可按需在 40 ° C~85 ° C 之是随意调节。

TOUCH THE "OPEN" AND "CLOSE", THE COVER 
WILL OPEN OR CLOSE AUTOMATIC.
The Inductor under the control panel, when you 
leave it 2-5 seconds, the cover will closed automatic.
Automatic system, Human-ceentered Design, 
Energy-saving and environment-friendly product. Safety and 
Health.
Everlasting mechansim. The temperature can be adjusted 
from 40°C(104°F)~85°C(185°F).

型号 容量 额定功率 额定电压 额定频率
TCB6702-1（单格 Single） 单 8.3L / 双 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6702-2（双格 Double） 单 8.3L / 双 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6501-1（单格 Single） 单 8.3L / 双 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCB6501-2（双格 Double） 单 8.3L / 双 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Chafing Dish
> s.s Legs
> Temperature Control

TCB6702-1 / TCB6702-2 TCB6501-1 / TCB6501-2

TCB6702-1  /  TCB6702-2
TCB6501-1  /  TCB6501-2
温控全钢全翻盖单 / 双格宴会餐炉

型号 容量 额定功率 额定电压 额定频率
TCB6708 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6507 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Soup Station 
> s.s Legs
> Temperature Control

TCB6708 TCS6507

TCB6708  /  TCS6507
温控全钢全翻盖球形宴会汤炉

型号 容量 额定功率 额定电压 额定频率
TCB6706 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6505 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> s.s Legs
> Temperature Control

TCB6706 TCS6505

TCB6706  /  TCS6505
温控全钢全翻盖双头宴会汤炉

> Round Chafing Dish 
> s.s Legs
> Temperature Control

型号 容量 额定功率 额定电压 额定频率
TCB6704 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
TCS6503 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

TCB6704
TCB6503

TCB6704  /  TCS6503
温控全钢全翻盖球形宴会餐炉

TCB67/65 SERIES（系列）

TOUCH M SERIES
触动系列
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列

触
动

M
 系

列

M24 SERIES M68 SERIES

型号 容量 额定功率 额定电压 额定频率
M2401-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M2401-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M2402-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M2402-2（双格 Double）  4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Chafing Dish 
> Gilt / Chrome Legs

M2401-1 / M2401-2 M2402-1 / M2402-2

> Show Window
> Automatic Open

M2401-1  /  M2401-2
M2402-1  /  M2402-2
电动可视镀金 / 铬长方型宴会餐炉

> Round Chafing Dish 
> Gilt / Chrome Legs

型号 容量 额定功率 额定电压 额定频率
M2403 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M2404 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

M2403 M2404

> Show Window
> Automatic Open

M2403  /  M2404
电动可视镀金 / 铬长方型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
M2405 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M2406 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> Gilt / Chrome Legs

M2405 M2406

> Show Window
> Automatic Open

M2405  /  M2406
电动可视镀金 / 铬长方型宴会汤炉

型号 容量 额定功率 额定电压 额定频率
M2407 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M2408 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Soup Station 
> Gilt / Chrome Legs

M2407 M2408

> Show Window
> Automatic Open

M2407  /  M2408
电动可视镀金 / 铬球型宴会汤炉

型号 容量 额定功率 额定电压 额定频率
M6801-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6801-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6801G-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6801G-2（双格 Double）  4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Chafing Dish 
> Gilt / Chrome Legs

M6801-1 / M6801-2 M6801G-1/ M6801G-2

> Show Window
> Automatic Open

M6801-1  /  M6801-2
M6801G-1  /  M6801G-2
电动可视镀金 / 铬长方型宴会餐炉

> Round Chafing Dish 
> Gilt / Chrome Legs

型号 容量 额定功率 额定电压 额定频率
M6803 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6803G 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

M6803 M6803G

> Show Window
> Automatic Open

M6803  /  M6803G
电动可视镀金 / 铬球型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
M6805 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6805G 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> Gilt / Chrome Legs

M6805 M6805G

> Show Window
> Automatic Open

M6805  /  M6805G
电动可视镀金 / 铬长方型宴会汤炉

型号 容量 额定功率 额定电压 额定频率
M6807 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6807G 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Soup Station 
> Gilt / Chrome Legs

M6807 M6807G

> Show Window
> Automatic Open

M6807  /  M6807G
电动可视镀金 / 铬球型宴会汤炉

（系列） （系列）
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M67 SERIES M67/M65 SERIES

型号 容量 额定功率 额定电压 额定频率
M6701-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6701-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6701G-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6701G-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

M6701-1 / M6701-2 M6701G-1/ M6701G-2

> Oblong Chafing Dish 
> Gilt / Chrome Legs

> Show Window
> Automatic Open

M6701-1  /  M6701-2
M6701G-1  /  M6701G-2
电动可视镀金 / 铬长方型宴会餐炉

> Round Chafing Dish 
> Gilt / Chrome Legs

型号 容量 额定功率 额定电压 额定频率
M6703 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6703G 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

M6703 M6703G

> Show Window
> Automatic Open

M6703  /  M6703G
电动可视镀金 / 铬球型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
M6705 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6705G 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> Gilt / Chrome Legs

M6705 M6705G

> Show Window
> Automatic Open

M6705  /  M6705G
电动可视镀金 / 铬长方型宴会汤炉

（系列） （系列）

型号 容量 额定功率 额定电压 额定频率
M6707 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6707G 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Soup Station 
> Gilt / Chrome Legs

M6707 M6707G

> Show Window
> Automatic Open

M6707  /  M6707G
电动可视镀金 / 铬球型宴会汤炉

型号 容量 额定功率 额定电压 额定频率
M6702-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6702-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6501-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6501-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Chafing Dish 
> s.s Legs

M6702-1 / M6702-2 M6501-1/ M6501-2

> Show Window
> Automatic Open

M6702-1  /  M6702-2
M6501-1  /  M6501-2
电动可视全钢长方型宴会餐炉

> Round Chafing Dish 
> s.s Legs

型号 容量 额定功率 额定电压 额定频率
M6704 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6503 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

M6704 M6503

> Show Window
> Automatic Open

M6704  /  M6503
电动可视全钢球型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
M6706 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6505 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> s.s Legs

M6706 M6505

> Show Window
> Automatic Open

M6706  /  M6505
电动可视全钢长方型宴会汤炉

型号 容量 额定功率 额定电压 额定频率
M6708 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
M6507 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Soup Station 
> s.s Legs

M6708 M6507

> Show Window
> Automatic Open

M6708  /  M6507
电动可视全钢球型宴会汤炉
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H24 SERIES（系列）

> Round  Soup Station 
> Gilt / Chrome Legs

H2407  /  H2408
电动镀金全翻盖球形宴会汤炉

H2405 H2406

> Oblong Soup Station 
> Gilt / Chrome Legs

型号 容量 额定功率 额定电压 额定频率
H2405 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H2406 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

H2405  /  H2406
电动镀金 / 镀铬全翻盖双头宴会汤炉

H68 SERIES

H6803 H6803G 

> Round Chafing Dish 
> Gilt / Chrome Legs

型号 容量 额定功率 额定电压 额定频率
H6803 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6803G 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

H6803  /  H6803G
电动镀金 / 铬全翻盖球形宴会餐炉

H6805

H6807

H6805G 

型号 容量 额定功率 额定电压 额定频率
H6805 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6805G 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> Gilt / Chrome Legs

H6805  /  H6805G
电动镀金 / 铬全翻盖双头宴会汤炉

（系列）

型号 容量 额定功率 额定电压 额定频率
H6801-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6801-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6801G-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6801G-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Chafing Dish 
> Gilt / Chrome Legs

H6801-1  /  H6801-2
H6801G-1  /  H6801G-2
电动可视全钢长方型宴会餐炉

H6801-1 / H6801-2H6801-1 / H6801-2

> Round Soup Station 
> Gilt/Chrome Legs

H6807  /  H6807G
电动镀金全翻盖球形宴会汤炉

型号 容量 额定功率 额定电压 额定频率
H2401-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H2401-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H2402-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H2402-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

H2401-1/H2401-2 H2402-1/H2402-2

> Oblong Chafing Dish 
> Gilt / Chrome Legs

> Automatic Open

H2401-1  /  H2401-2
H2402-1  /  H2402-2
电动全钢全翻盖球形宴会汤炉

> Round Chafing Dish
> Gilt / Chrome Legs

型号 容量 额定功率 额定电压 额定频率
H2403 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H2404 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

H2403 H2404

> Automatic Open

H2403  /  H2404
电动可视镀金 / 铬球型宴会餐炉

> Automatic Open

型号 容量 额定功率 额定电压 额定频率
H2407 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H2408 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

型号 容量 额定功率 额定电压 额定频率
H6807 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6807G 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Automatic Open > Automatic Open

> Automatic Open

> Automatic Open

> Automatic Open

H6807GH2407 H2408
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

触
动

H 系
列

触
动

H 系
列

H67 SERIES H67/H65 SERIES（系列） （系列）

> Oblong Chafing Dish 
> Gilt / Chrome Legs

H6701-1  /  H6701-2
H6701G-1  /  H6701G-2
电动镀金全翻盖单 / 双格宴会餐炉

型号 容量 额定功率 额定电压 额定频率
H6703 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6703G 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Chafing Dish 
> Gilt / Chrome Legs

H6703  /  H6703G
电动镀金 / 铬全翻盖球形宴会餐炉

H6703

H6701

H6703G

M6701G

型号 容量 额定功率 额定电压 额定频率
H6702-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6702-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6501-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6501-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Chafing Dish 
> s.s Legs
> Automatic Open

H6702-1  /  H6702-2
H6501-1  /  H6501-2
电动镀金全翻盖单 / 双格宴会餐炉

H6501-1 / H6501-2H6702-1 / H6702-2

型号 容量 额定功率 额定电压 额定频率
H6704 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6503 6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

H6704 H6503

> Round Chafing Dish 
> s.s Legs
> Automatic Open

H6704  /  H6503
电动全钢全翻盖球形宴会餐炉

型号 容量 额定功率 额定电压 额定频率
H6706 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6505 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

H6706 H6505

> Oblong Soup Station 
> s.s Legs
> Automatic Open

H6706  /  H6505
电动全钢全翻盖双头宴会汤炉

型号 容量 额定功率 额定电压 额定频率
H6708 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6507 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

H6708 H6507

> Round Soup Station 
> s.s Legs
> Automatic Open

H6708  /  H6507
电动全钢全翻盖球形宴会汤炉

型号 容量 额定功率 额定电压 额定频率
H6701-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6701-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6701G-1（单格 Single） 8.3L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6701G-2（双格 Double） 4L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Automatic Open

> Automatic Open

H6705 H6705G

> Oblong Soup Station 
> Gilt / Chrome Legs

型号 容量 额定功率 额定电压 额定频率
H6705 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H6705G 4.6L*2 250W 220-240V~ 50/60HZ 适用 10A 国际插头

H6705  /  H6705G
电动镀金全翻盖双头宴会汤炉

> Automatic Open

> Round Soup Station 
> Gilt / Chrome Legs

H6707  /  H6707G
电动镀金全翻盖球形宴会汤炉

型号 容量 额定功率 额定电压 额定频率
H2407 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头
H2407G 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

> Automatic Open

H6707GH6707
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

可
视

S 系
列

触
动

M
D 系

列

MD SERIES（系列）

本公司电磁炉专用

MD101 MD102

MD101G MD102G

> Electrical 2/3 GN Chafer
> Glass / steel Lid
> Self-opening

MD202  /  MD202G
感应碟菲炉

型号 容量 额定功率 额定电压 额定频率
MD202 5.1L 250W 220-240V~ 50/60HZ 配 DB-230 适用 10A 国际插头
MD202G 5.1L 250W 220-240V~ 50/60HZ 配 DB-230 适用 10A 国际插头

MD202 MD202G

> Electrical 1/1 GN Chafer
> Glass / steel Lid
> Self-opening

MD204  /  MD204G
感应碟菲炉

型号 容量 额定功率 额定电压 额定频率
MD204 单 7.6L 双 3.4L*2 250W 220-240V~ 50/60HZ
MD204G 单 7.6L 双 3.4L*2 250W 220-240V~ 50/60HZ

MD204 MD204G

> Round 38cm Electrical Chafer
> Glass / steel Lid
> Self-opening

MD201  /  MD201G
感应碟菲炉

型号 容量 额定功率 额定电压 额定频率
MD201 6L 250W 220-240V~ 50/60HZ 配 DB-230 适用 10A 国际插头
MD201G 6L 250W 220-240V~ 50/60HZ 配 DB-230 适用 10A 国际插头

MD201 MD201G

> Induction Round 38cm Chafer
> Glass / Steel Lid
> Self-opening

> Induction 2/3 GN Chafer
> Glass / Steel Lid
> Self-opening

MD101  /  MD101G MD102  /  MD102G 
专用碟菲炉 专用碟菲炉

SHOW WINDOW S SERIES
可视 S 系列

Special show window
Use the Dupont's high tech material, Original creation 
making craft, no steam and greasy stain.

可视窗
采用杜邦公司高科技材料，独创制作工艺，可视窗防
雾化，防油腻。

sculpt
Perfect design, solid brass legs and line.

造型
精致的脚部造型，线条简约，造型优美。

plane
New style designed in smooth plate, detachable cover 
for easy cleaning, stronger body to service long life.

平面 
采用新型周边平面设计，防侧漏，易擦洗，加固了炉
身的强度，延长使用寿命。

Designed for KINGO Induction Cooker Only
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

可
视

S 系
列

可
视

S 系
列

标配酒精炉可选配电热板 标配酒精炉可选配电热板S24 SERIES S68 SERIES（系列） （系列）

型号 容量 额定功率 额定电压 额定频率
S2401-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S2401-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S2402-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S2402-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S2401-1 / S2401-2 S2402-1 / S2402-2

> Oblong Chafing Dish 
> Gilt / Chrome Legs
> Show Window

S2401-1  /  S2401-2
S2402-1  /  S2402-2
可视镀金 / 铬长方型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
S2403 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S2404 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S2403 S2404

> Round Chafing Dish 
> Gilt / Chrome Legs
> Show Window

S2403  /  S2404
可视镀金 / 铬球型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
S2405 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S2406 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S2405 S2406

> Oblong Soup Station 
> Gilt / Chrome Legs
> Show Window

S2405  /  S2406
可视镀金 / 铬长方型宴会汤炉

型号 容量 额定功率 额定电压 额定频率
S2407 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S2408 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S2407 S2408

> Round Shop Station
> Gilt / Chrome Legs
> Show Window

S2407  /  S2408
可视镀金 / 铬球型宴会汤炉

> Oblong Chafing Dish 
> Gilt / Chrome Legs
> Show Window

S6801-1  /  S6801-2
S6801G-1  /  S6801G-2
可视镀金 / 铬长方型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
S6801-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6801-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6801G-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6801G-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S6801-1/ S6801-2 S6801G-1 / S6801G-2

> Round Chafing Dish 
> Gilt / Chrome Legs
> Show Window

S6803  /  S6803G
可视镀金 / 铬球型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
S6803 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6803G 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S6803 S6803G

> Oblong Soup Station 
> Gilt / Chrome Legs
> Show Window

S6805  /  S6805G
可视镀金 / 铬长方型宴会汤炉

型号 容量 额定功率 额定电压 额定频率
S6805 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6805G 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S6805 S6805G

> Round Soup Station
> Gilt / Chrome Legs
> Show Window

S6807  /  S6807G
可视镀金 / 铬球型宴会汤炉

型号 容量 额定功率 额定电压 额定频率
S6807 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6807G 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S6807 S6807G
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

可
视

S 系
列

可
视

S 系
列

标配酒精炉可选配电热板 标配酒精炉可选配电热板S67 SERIES S67/65 SERIES（系列） （系列）

型号 容量 额定功率 额定电压 额定频率
S6703 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6703G 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S6703 S6703G

> Round Chafing Dish 
> Gilt / Chrome Legs
> Show Window

S6703  /  S6703G
可视镀金 / 铬球型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
S6705 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6705G 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S6705 S6705G

> Oblong Soup Station 
> Gilt / Chrome Legs
> Show Window

S6705  /  S6705G
可视镀金 / 铬长方型宴会汤炉

型号 容量 额定功率 额定电压 额定频率
S6707 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6707G 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S6707 S6707G

> Round Soup Station 
> Gilt / Chrome Legs
> Show Window

S6707  /  S6707G
可视镀金 / 铬球型宴会汤炉

> Oblong Chafing Dish 
> s.s Legs
> Show Window

S6702-1  /  S6702-2
S6501-1  /  S6501-2
可视全钢长方型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
S6702-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6801-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6501-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6501-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S6702-1/ S6702-2 S6501-1 / S6501-2

> Round Chafing Dish 
> s.s Legs
> Show Window

S6704  /  S6503
可视全钢球型宴会餐炉

型号 容量 额定功率 额定电压 额定频率
S6704 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6503 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S6704 S6503

> Oblong Soup Station 
> s.s Legs
> Show Window

S6706  /  S6505
可视全钢长方型宴会汤炉

型号 容量 额定功率 额定电压 额定频率
S6706 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6505 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S6706 S6505

> Round Soup Station 
> s.s Legs
> Show Window

S6708  /  S6507
可视全钢球型宴会汤炉

型号 容量 额定功率 额定电压 额定频率
S6708 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6507 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

S6708 S6507

型号 容量 额定功率 额定电压 额定频率
S6701-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6701-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6701G-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
S6701G-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Chafing Dish 
> Gilt / Chrome Legs
> Show Window

S6701-1  /  S6701-2
S6701G-1  /  S6701G-2
可视镀金 / 铬长方型宴会餐炉

S6701-1 / S6701-2 S6701G-1 / S6701G-2
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

传
统

B 系
列

传
统

B 系
列

标配酒精炉可选配电热板 标配酒精炉可选配电热板B24 SERIES B68 SERIES（系列） （系列）

> Oblong Chafing Dish 
> Gilt / Chrome Legs

B2401-1  /  B2401-2
B2402-1  /  B2402-2
镀金全翻盖单 / 双格宴会餐炉

> Round Chafing Dish 
> Gilt / Chrome Legs

> Oblong Soup Station 
> Gilt / Chrome Legs

B2403  /  B2404 B6805  /  B6805G
镀金全翻盖双格宴会餐炉 镀金全翻盖双头宴会汤炉

> Oblong Soup Station 
> Gilt / Chrome Legs

B2405  /  B2406
镀金全翻盖双头宴会汤炉

> Round Soup Station 
> Gilt / Chrome Legs

B2407  /  B2408
镀金全翻盖球形宴会汤炉

> Oblong Chafing Dish 
> Gilt / Chrome Legs

B6801-1  /  B6801-2
B6801G-1  /  B6801G-2
镀金全翻盖单 / 双格宴会餐炉

型号 容量 额定功率 额定电压 额定频率
B6803 / 
B6803G 6L 380W 220-240V~ 50/60HZ 适用 10A

国际插头

> Round Chafing Dish 
> Gilt / Chrome Legs

B6803  /  B6803G
镀金全翻盖球形宴会餐炉

型号 容量 额定功率 额定电压 额定频率
B6807 / 
B6807G 4.6L 380W 220-240V~ 50/60HZ 适用 10A

国际插头

> Round Soup Station 
> Gilt / Chrome Legs

B6807  /  B6807G
镀金全翻盖球形宴会汤炉

型号 容量 额定功率 额定电压 额定频率

K6801-1 8.3L 380W 220-240V~ 50/60HZ 适用 10A
国际插头

型号 容量 额定功率 额定电压 额定频率

K6803 6L 380W 220-240V~ 50/60HZ 适用 10A
国际插头

> Chafing Dish
> All Gold Plated

K6801-1
镀金全翻盖宴会餐炉

> Round Chafing Dish 
> All Gold Plated

K6803
镀金全翻盖宴会餐炉

型号 容量 额定功率 额定电压 额定频率
B2401-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B2401-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B2402-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B2402-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

型号 容量 额定功率 额定电压 额定频率
B6801-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6801-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6801G-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6801G-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

B2401-1/B2401-2 B6801-1 / B6801-2

B2403

B2405

B2407

B2402-1/B2402-2 B6801G-1 / B6801G-2

 B6805GB6805
B2404

B2406

B2408

型号 容量 额定功率 额定电压 额定频率
B2403 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B2404 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

型号 容量 额定功率 额定电压 额定频率
B6805 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6805G 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

型号 容量 额定功率 额定电压 额定频率
B2405 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B2406 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

型号 容量 额定功率 额定电压 额定频率
B2407 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B2408 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

传
统

B 系
列

传
统

B 系
列

标配酒精炉可选配电热板 标配酒精炉可选配电热板B67 SERIES B65/20/21 SERIES（系列） （系列）

> Oblong Chafing Dish 
> s.s  Legs

> Oblong Chafing Dish 
> Gilt Legs

B6501-1  /  B6501-2 2001-1  /  2001-2
全钢全翻盖单 / 双格宴会餐炉 镀金宴会餐炉

型号 容量 额定功率 额定电压 额定频率
B6501-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6501-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2001-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2001-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Chafing Dish 
> s.s Legs

> Chafing Dish 
> Gilt Legs

B6503 2002
全钢全翻盖球形宴会餐炉 镀金宴会餐炉

型号 容量 额定功率 额定电压 额定频率
B6503 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2002 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Oblong Soup Station 
> s.s Legs

> Oblong Chafing Dish 
> Gilt Legs

B6505 2003
全钢全翻盖球形宴会汤炉 镀金宴会汤炉

型号 容量 额定功率 额定电压 额定频率
B6505 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2003 4.5L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Soup Station 
> s.s Legs

> Chafing Dish 

B6507 2101
全钢全翻盖球形宴会汤炉 全钢宴会餐炉

型号 容量 额定功率 额定电压 额定频率
B6507 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2101 8L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

型号 容量 额定功率 额定电压 额定频率
B6703 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6703G 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6704 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

B6703GB6703 B6704

> Round Chafing Dish 
> Gilt / s.s / Chrome Legs

B6703  /  B6704
镀金 / 全钢全翻盖球形宴会餐炉

B6705G B6706

> Oblong Soup Station 
> Gilt / s.s / Chrome Legs

B6705  /  B6706
镀金全翻盖双头宴会汤炉

型号 容量 额定功率 额定电压 额定频率
B6505 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6505G 4.6L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6706 4.5L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

B6705

型号 容量 额定功率 额定电压 额定频率
B6701-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6701-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6701G-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6701G-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6702-1（单格 Single） 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6702-2（双格 Double） 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

B6701-1 / B6701-2 B6702-1/ B6702-2

> Oblong Chafing Dish 
> Gilt / s.s / Chrome Legs

B6701-1  /  B6701-2
B6702-1  /  B6702-2
镀金 / 全钢全翻盖单 / 双格宴会餐炉

B6701G-1 / B6701G-2

> Round Soup Station 
> Gilt / s.s / Chrome Legs

B6707  /  B6708
镀金全翻盖球形宴会汤炉

型号 容量 额定功率 额定电压 额定频率
B6707 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6707G 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
B6708 4.6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

B6707GB6707 B6708
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

传
统

2 系
列

传
统

2 系
列

标配酒精炉可选配电热板 标配酒精炉可选配电热板21/22/23/24 SERIES 24/25/26 SERIES（系列） （系列）

型号 容量 额定功率 额定电压 额定频率
2102 4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2203 4.5L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Chafing Dish > Soup Station

2102 2203
全钢宴会餐炉 宴会汤炉

型号 容量 额定功率 额定电压 额定频率
2103 4.5L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

2301 4.6L 180W 220-240V~ 50/60HZ 适用 DB-180A 电热板
适用 10A 国际插头

> Soup Station > Chafing Dish

2103 2301
全钢宴会汤炉 宴会餐炉

型号 容量 额定功率 额定电压 额定频率
2201  4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2401 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Chafing Dish
> Rectangle Chafing Dish
> Gilt Legs

2201 2401
宴会餐炉 镀金宴会餐炉

型号 容量 额定功率 额定电压 额定频率
2202  8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2405 4.5L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Chafing Dish
> RectangleSoup Station
> Gilt Legs

2202 2405
宴会餐炉 镀金宴会汤炉

型号 容量 额定功率 额定电压 额定频率
A7905  8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
A9801  8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Eco Chafing Dish > Half Roll-top Chafing Dish

A7905 A9801
简易餐炉 半翻盖餐炉

> Round Dish 
> Gilt Legs

> Soup Station

2403 2503
镀金宴会餐炉 宴会汤炉

型号 容量 额定功率 额定电压 额定频率
2403 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2503 6L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

>Rectangle Soup Station 
> Chrome Legs

> Chafing Dish

2406 2501
全钢宴会汤炉 宴会餐炉

型号 容量 额定功率 额定电压 额定频率
2406 4.5L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2501 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Chafing Dish 
> Chrome Legs

> Chafing Dish

2402 2502
全钢宴会餐炉 宴会餐炉

型号 容量 额定功率 额定电压 额定频率
2402 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2502 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Round Dish 
> Chorme Legs

> Round Dish 
> Chorme Legs

> Chafing Dish

2404 2603
全钢宴会餐炉 宴会餐炉

型号 容量 额定功率 额定电压 额定频率
2404 7L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

2603 5L 180W 220-240V~ 50/60HZ 适用 10A 国际插头
配专用 DB-180A 电热板

> Round Dish 
> Gilt Legs

2407 2408
全钢宴会餐炉 宴会餐炉

型号 容量 额定功率 额定电压 额定频率
2407 4.5L 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2408 4.5L 180W 220-240V~ 50/60HZ 适用 10A 国际插头
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

小
型

C 系
列

传
统

2 系
列

标配酒精炉可选配电热板 标配酒精炉可选配电热板26/27 SERIES C24/68 SERIES（系列） （系列）

型号 容量 额定功率 额定电压 额定频率
2802  10L 180W 220-240V~ 50/60HZ 适用 10A 国际插头

> Soup Station W
> Chrome Legs

2802
宴会汤炉

型号 容量 额定功率 额定电压 额定频率
2604 10L 180W 220-240V~ 50/60HZ 适用 10A 国际插头
2703 7L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Soup Station > Round Chafing Dish

2604 2703
宴会汤炉 宴会餐炉

型号 容量 额定功率 额定电压 额定频率
2605 10L 180W 220-240V~ 50/60HZ 适用 10A 国际插头
2704 7L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Soup Station > Round Built-in Chafing Dish

2605 2704
宴会汤炉 嵌入式宴会餐炉

型号 容量 额定功率 额定电压 额定频率
2701  4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头
2705 8.3L 380W 220-240V~ 50/60HZ 适用 10A 国际插头

> Rectangle Chafing Dish > 1/1 GN built-in Chafing Dish

2701 2705
宴会餐炉 嵌入式宴会餐炉

型号 容量 额定功率 额定电压 额定频率
2702  4L*2 380W 220-240V~ 50/60HZ 适用 10A 国际插头

2801 5L 180W 220-240V~ 50/60HZ 适用 10A 国际插头
适合 DB-180A 专用电热板

> Rectangle Soup Station > Chafing Dish

2702 2801
全钢宴会汤炉 嵌入式宴会餐炉

型号 容量 额定功率 额定电压 额定频率
C2401-1（单格 Single） 4.8L 280W 220-240V~ 50/60HZ 适用 10A 国际插头
C2401-2（双格 Double） 2.1L*2 280W 220-240V~ 50/60HZ 适用 10A 国际插头
C6801-1（单格 Single） 4.8L 280W 220-240V~ 50/60HZ 适用 10A 国际插头
C6801-2（双格 Double） 2.1L*2 280W 220-240V~ 50/60HZ 适用 10A 国际插头

C2401-1/ C2401-2 C6801-1 / C6801-2

> Square Chafing Dish 
> Gilt Legs

C2401-1  /  C2401-2
C6801-1  /  C6801-2
镀金全翻盖单格 / 双格宴会餐炉

型号 容量 额定功率 额定电压 额定频率
C2405 4.6L 280W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-280A 专用电热板C6805 4.6L 280W 220-240V~ 50/60HZ

C2405 C6805

> Square Soup Station 
> Gilt Legs

C2405  /  C6805
镀金全翻盖单头宴会汤炉

型号 容量 额定功率 额定电压 额定频率
C2409T( 原 B2409T) 4.6L 250W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-280A 专用电热板C6809T( 原 B6809T) 4.6L 250W 220-240V~ 50/60HZ

C2409T C6809T

> Round Soup Station 
> Gilt Legs

C2409T  /  C6809T
镀金全翻盖球形宴会汤炉

> Round Chafing Dish 
> Gilt Legs

C2409  /  C6809
镀金全翻盖球形宴会餐炉

型号 容量 额定功率 额定电压 额定频率
C2409 7.6L 280W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-280A 专用电热板C6809( 原 6809) 7.6L 280W 220-240V~ 50/60HZ

C2409 C6809
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

W
系

列

小
型

C 系
列

标配酒精炉可选配电热板C67/65 SERIES（系列） （系列）

> Square Chafing Dish 
> Gilt / s.s Legs

C6701-1  /  C6701-2
C6702-1  /  C6702-2
镀金 / 全钢全翻盖单 / 双格宴会餐炉

型号 容量 额定功率 额定电压 额定频率
C6701-1（单格 Single） 4.8L 280W 220-240V~ 50/60HZ

适用 10A 国际插头
适合 DB-280A 专用电热板

C6701-2（双格 Double） 2.1L*2 280W 220-240V~ 50/60HZ
C6702-1（单格 Single） 4.8L 280W 220-240V~ 50/60HZ
C6702-2（双格 Double） 2.1L*2 280W 220-240V~ 50/60HZ

C6701-1/ C6701-2 C6702-1 / C6702-2

 C6709 C6710

型号 容量 额定功率 额定电压 额定频率
C6709( 原 B6709) 7.6L 280W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-280A 专用电热板C6710( 原 B6710) 7.6L 280W 220-240V~ 50/60HZ

> Round Chafing Dish 
> Gilt / s.s Legs

C6709  /  C6710
镀金 / 全钢全翻盖球形宴会餐炉

型号 容量 额定功率 额定电压 额定频率
C6705 4.6L 280W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-280A 专用电热板C6706 4.6L 280W 220-240V~ 50/60HZ

C6705 C6706

> Square Soup Station 
> Gilt / s.s Legs

C6705  /  C6706
镀金 / 全钢全翻盖单头宴会汤炉

型号 容量 额定功率 额定电压 额定频率
C6709T( 原 B6709T) 4.6L 280W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-280A 专用电热板C6710T( 原 B6710T) 4.6L 280W 220-240V~ 50/60HZ

C6709T C6710T

> Round Soup Station 
> Gilt / s.s Legs

C6709T  /  C6710T
镀金 / 全钢全翻盖球形宴会汤炉

使用天然实木材料更加隔热、不易烫
温度可在常温到沸点任意调节
木材与不锈钢结合的一体化设计

Use natural wood materials more heat insulation, not easy to burn.
The temperature can be adjusted from normal temperature to 
boling. integrated design of wood and stainless steel

The appearance of the personalized 
design of convex and concave

Notch design for convenient

Collocation thermostat 
electric warmer inside

Unique design of cooling hole
Antiskid mat provided 
on the bottom

W SERIES

> Oblong Chafing Dish with Glass Lid
> Electric Heater  Wooden Stand 8.3L

W104
木制餐炉

> Square Chafing Dish with Glass Lid
> Electric Heater Wooden Stand 4.8L

W102
木制餐炉

> Oblong Chafing Dish with Glass Lid
> Electric Heater Wooden Stand 6.0L

W101
木制餐炉

可持续保温
6 小时

> Wooden Buffet Stand

W2850
木制曼哈顿 木制曼哈顿

> Wooden Buffet Stand

W2830

> Oblong Chafing Dish with Coldice pack 
Display

CH2201
冷鲜宴会餐炉

外观采用凸与凹的个性设计

方便取锅的缺口设计

内有搭配高温电热板
独特的散热孔设计 底部有防滑脚垫
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

J
系

列

J
系

列

材料
全身采用 304 不锈钢精致打造。

The whole body is made of 304 
stainless steel.

> Round Steel Lid Vision Induction 
   Chafing dish, W/ss insert

> Round Glass Lid Vision Induction 
   Chafing dish, W/ss insert

宴会餐炉

宴会餐炉

J301PG  /  J305PG

J301P  /  J305P

> Round Steel Lid Vision Induction 
   Chafing dish, W/ss insert

> Round Glass Lid Vision Induction 
   Chafing dish, W/ss insert

宴会餐炉

宴会餐炉

J301RG  /  J305RG

J301R  /  J305R

> Round Steel Lid Vision Induction 
   Chafing dish, W/ss insert

> Round Glass Lid Vision Induction 
   Chafing dish, W/ss insert

宴会餐炉

宴会餐炉

J301WG  /  J305WG

J301W  /  J305W

J SERIES（系列）

宴会餐炉

J302PG  /  J306PG
J302RG  /  J306RG
J302WG  /  J306WG

> Square Steel Lid Vision Induction  
   Chafing dish, w/SS insert

Adoption of special technology, 
Keep the lid permanently sesled.

可调节旋钮
采用特殊技术，
让盖子保持持久密封。

可视窗 
采用杜邦公司高科技材料，独创制作
工艺，可视窗防雾化，防油腻。

Special show window use the Duont's 
hightech matterial, Original creation 
making craft, no steam and greasy stain.

宴会餐炉

J302P  /  J306P
J302R  /  J306R
J302W  /  J306W

> Square Steel Lid Vision Induction  
   Chafing dish, w/SS insert

宴会餐炉

型号 容量 额定功率 额定电压 额定频率
J701P/J705P 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ 专用电热板
最高温度≤ 100℃ 

J701R/J705R 6L 500W 220-240V~ 50/60HZ
J701W/J705W 6L 500W 220-240V~ 50/60HZ

> Round Steel Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand 

J701PG  /  J705PG
J701RG  /  J705RG
J701WG /  J705WG

标配酒精炉可选配电热板

宴会餐炉

型号 容量 额定功率 额定电压 额定频率
J701PG/J705PG 6L 350W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ 专用电热板
最高温度≤ 100℃ 

J701RG/J705RG 6L 350W 220-240V~ 50/60HZ
J701WG/J705WG 6L 350W 220-240V~ 50/60HZ

> Round Glass Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand

J701P  /  J705P
J701R  /  J705R
J701W  /  J705W
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

J
系

列

J
系

列

J SERIES J SERIES（系列） （系列）
标配酒精炉可选配电热板 标配酒精炉可选配电热板

型号 容量 额定功率 额定电压 额定频率
J702PG/J706PG 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ 专用电热板
最高温度≤ 100℃ 

J702RG/J706RG 6L 500W 220-240V~ 50/60HZ
J702WG/J706WG 6L 500W 220-240V~ 50/60HZ

> Square Steel Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand

宴会餐炉

J702PG  /  J706PG
J702RG  /  J706RG
J702WG  /  J706WG

> Square Steel Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand and  fuel holder

宴会餐炉

J402PG  /  J406PG
J402RG  /  J406RG
J402WG  /  J406WG

型号 容量 额定功率 额定电压 额定频率
J702P/J706P 3.8L 350W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-350RJ 专用电热板
最高温度≤ 100℃ 

J706R/J706R 3.8L 350W 220-240V~ 50/60HZ
J706W/J706W 3.8L 350W 220-240V~ 50/60HZ

> Square Glass Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand

宴会餐炉

J702P  /  J706P
J702R  /  J706R
J702W  /  J706W

> Square Glass Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand and  fuel holder

宴会餐炉

J402P  /  J406P
J402R  /  J406R
J402W  /  J406W

型号 容量 额定功率 额定电压 额定频率
J401PG/J405PG 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ 专用电热板
最高温度≤ 100℃ 

J401RG/J405RG 6L 500W 220-240V~ 50/60HZ
J401WG/J405WG 6L 500W 220-240V~ 50/60HZ

> Round Steel Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand and  fuel holder

> Stand for Round 30cm/38cm 
   Chafing Dish

> Stand for Mini Sqare 1/2 Chafing Dish
> Stand for Sqare GN2/3 Chafing Dish

宴会餐炉

宴会餐炉

宴会餐炉

J401PG  /  J405PG
J401RG  /  J405RG
J401WG  /  J405WG

C70P  /  C80P
C70R  /  C80R
C70W  /  C80W

C90P  /  C100P
C90R  /  C100R
C90W  /  C100W

型号 容量 额定功率 额定电压 额定频率
J401P/J405P 3.8L 350W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ 专用电热板
最高温度≤ 100℃ 

J401R/J405R 3.8L 350W 220-240V~ 50/60HZ
J401W/J405W 3.8L 350W 220-240V~ 50/60HZ

> Round Glass Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand and  fuel holder

宴会餐炉

J401P/J405P
J401R/J405R
J401W/J405W

型号 容量 额定功率 额定电压 额定频率
J402PG/J406PG 6LL 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ 专用电热板
最高温度≤ 100℃ 

J402RG/J406RG 6LL 500W 220-240V~ 50/60HZ
J402WG/J406WG 6LL 500W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J402P/J406P 6LL 350W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-350RJ 专用电热板
最高温度≤ 100℃ 

J402R/J406R 6LL 350W 220-240V~ 50/60HZ
J402W/J406W 6LL 350W 220-240V~ 50/60HZ
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

J
系

列

J
系

列

J SERIES J SERIES（系列） （系列）
标配酒精炉可选配电热板 标配酒精炉可选配电热板

J701B/J705B J701BG/J705BG

型号 容量 额定功率 额定电压 额定频率
J701B/J701BG 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板
最高温度≤ 100℃ J705B/J705BG 3.8L 350W 220-240V~ 50/60HZ

> Round Glass Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand

J701B  /  J701BG  /  J705B  /  J705BG
圆形餐炉玻璃盖 / 钢盖

> Round Glass Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand and  fuel holder

J401B  /  J401BG  /  J405B  /  J405BG
圆形餐炉玻璃盖 / 钢盖

J702B/J706B J702BG/J706BG

型号 容量 额定功率 额定电压 额定频率
J702B/J702BG 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板
最高温度≤ 100℃ J706B/J706BG 3.8L 350W 220-240V~ 50/60HZ

> Square Glass Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand

J702B  /  J702BG  /  J706B  /  J706BG
方形餐炉玻璃盖 / 钢盖

> Square Glass Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand and  fuel holder

J402B  /  J402BG  /  J406B  /  J406BG
方形餐炉玻璃盖 / 钢盖

J701S/J705S J701SG/J705SG

型号 容量 额定功率 额定电压 额定频率
J701S/J701SG 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板
最高温度≤ 100℃ J705S/J705SG 3.8L 350W 220-240V~ 50/60HZ

> Round Glass Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand

J701S  /  J701SG  /  J705S  /  J705SG
圆形餐炉玻璃盖 / 钢盖

J702S/J706S J702SG/J706SG

型号 容量 额定功率 额定电压 额定频率
J702S/J702SG 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板
最高温度≤ 100℃ J706S/J706SG 3.8L 350W 220-240V~ 50/60HZ

> Square Glass Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand

J702S  /  J702SG  /  J706S  /  J706SG
方形餐炉玻璃盖 / 钢盖

J401B/J405B

J402B/J406B

J401BG/J405BG

J402BG/J406BG

型号 容量 额定功率 额定电压 额定频率
J401B/J401BG 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板
最高温度≤ 100℃ J405B/J405BG 3.8L 350W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
J402B/J402BG 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板
最高温度≤ 100℃ J406B/J406BG 3.8L 350W 220-240V~ 50/60HZ

J401S/J405S J401SG/J405SG

型号 容量 额定功率 额定电压 额定频率
J401S/J401SG 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板
最高温度≤ 100℃ J405S/J405SG 3.8L 350W 220-240V~ 50/60HZ

> Round Glass Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand and  fuel holder

J401S  /  J401SG  /  J405S  /  J405SG
圆形餐炉玻璃盖 / 钢盖

J402S/J406S J402SG/J406SG

型号 容量 额定功率 额定电压 额定频率
J402S/J402SG 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板
最高温度≤ 100℃ J406S/J406SG 3.8L 350W 220-240V~ 50/60HZ

> Square Glass Lid Vision Induction 
   Chafing dish, w/ss insert,With 
   stand and  fuel holder

J402S  /  J402SG  /  J406S  /  J406SG
方形餐炉玻璃盖 / 钢盖
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

J
系

列

J
系

列

J SERIES J SERIES（系列） （系列）

J401GCG/J405GCG J402GCG/J406GCG

标配酒精炉可选配电热板

型号 容量 额定功率 额定电压 额定频率
J401GCG/J405GCG 6L/3.8L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板
最高温度≤ 100℃ J402GCG/J406GCG 5.1L/3.8L 350W 220-240V~ 50/60HZ

> Round / Square steel Lid Vision
Induction Chafing dish, w/ss insert

J401GCG  /  J405GCG
J402GCG  /  J406GCG
镀金圆形 / 方形餐炉

J301B/J305B J301BG/J305BG

> Round Glass Lid Vision Induction 
Chafing dish, w/ss insert

J301B  /  J305B  /  J301BG  /  J305BG
圆形餐炉玻璃盖 / 钢盖

J301S/J305S J301SG/J305SG

> Round Glass Lid Vision Induction 
Chafing dish, w/ss insert

J301S  /  J305S  /  J301SG  /  J305SG
圆形餐炉玻璃盖 / 钢盖

J302B/J306B J302BG/J306BG

> Square Glass Lid Vision Induction 
Chafing dish, w/ss insert

J302B  /  J306B  /  J302BG  /  J306BG
方形餐炉玻璃盖 / 钢盖

J302S/J306S J302SG/J306SG

> Square Glass Lid Vision Induction 
Chafing dish, w/ss insert

J302S  /  J306S  /  J302SG  /  J306SG
方形餐炉玻璃盖 / 钢盖

> Oblong GN1/1 Glass Lid Vision
Induction Chafing dish, w/ss insert

J304K  /  J304KG
镀金方形餐炉

> Stand for Round 38cm/30cm 
Chafing Dish

C1530S  /  C1538S 
圆形餐炉框架

宴会餐炉
J301GCG  /  J305GCG

> Round Steel Lid Vision Induction 
Chafing dish, w/ss insert

> Stand for Round 38cm/30cm 
Chafing Dish

> Stand for Square GN2/3 GN1/2 
Chafing Dish

C1530B  /  C1538B C1523B  /  C1512B
圆形餐炉框架 方形餐炉框架

> Stand for Square GN2/3 GN1/2 
Chafing Dish

C1523S  /  C1512S
方形餐炉框架

> Round Glass Lid Vision Induction 
Chafing dish, w/ss insert 

J301K  /  J301KG  /  J305K  /  J305KG
圆形 / 方形餐炉框架
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

J
系

列

J
系

列

J SERIES（系列）
标配酒精炉可选配电热板

型号 容量 额定功率 额定电压 额定频率
J404K 8.3L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500 专用电热板J404KG 8.3L 500W 220-240V~ 50/60HZ

J404K J404KG

> Rectangle  Glass/s.s Lid Vision Induction 
Chafing dish, w/ss insert

J404K  /  J404KG
镀金圆形 / 方形餐炉

J SERIES（系列）

圆形餐炉框架
C70B  /  C80B

> Stand for Round 
30cm/38cm Chafing Dish

> Stand for Mini Square GN 
1/2 Chafing Dish

> Stand for Square GN 2/3 
Chafing Dish

C90B  /  C100B
圆形餐炉框架

> Stand for Round 
30cm/38cm Chafing Dish

圆形餐炉框架
C70S  /  C80S

> Stand for Mini Square GN 
1/2 Chafing Dish

> Stand for Square GN 2/3 
Chafing Dish

方形餐炉框架
C90S  /  C100S

> Stand for Round 
30cm/38cm Chafing Dish

圆形餐炉框架
C70G  /  C80G

> Stand for Mini Square GN 
1/2 Chafing Dish

> Stand for Square GN 2/3 
Chafing Dish

方形餐炉框架
C90G  /  C100G

> Stand for Oblong 
GN 1/1 Chafing Dish

1/1 方形餐炉框架
C104B  /  C104G  /  C104S

J302K/J306K J302KG/J306KG

> Square Glass/s.s Lid Vision Induction 
Chafing dish, w/ss insert

J302K  /  J302KG  /  J306K  /  J306KG
方形餐炉玻璃盖 / 钢盖

型号 容量 额定功率 额定电压 额定频率
J401K/J405KG 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ 专用电热板
最高温度≤ 100° CJ401KG/J405KG 3.8L 350W 220-240V~ 50/60HZ

> Round Glass/s.s Lid Vision Induction Chafing dish, 
w/ss insert, with stand and fuel holder

J401K  /  J401KG  /  J405K  /  J405KG
镀金圆形 / 方形餐炉

J401K/J405K J401KG/J405KG

型号 容量 额定功率 额定电压 额定频率
J402K/J402KG 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-350 专用电热板
最高温度≤ 100° CJ406KG/J406KG 3.8L 350W 220-240V~ 50/60HZ

> Square Glass/s.s Lid Vision Induction Chafing dish, 
w/ss insert, with stand and fuel holder

J402K  /  J402KG  /  J406K  /  J406KG
镀金圆形 / 方形餐炉

J402K/J406K J406KG/J406KG
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

J
系

列

J
系

列

J SERIES J SERIES（系列） （系列）

宴会餐炉
J301  /  J305

> Round Glass Lid Vision Chafing 
   dish, w/ss insert

> Round Steel Lid Vision Chafing 
   dish, w/ss insert

J301G  /  J305G
宴会餐炉

宴会餐炉
J302  /  J306

> Square Glass Lid Vision Chafing 
   dish, w/ss insert

> Square Steel Lid Vision Chafing 
   dish, w/ss insert

J302G  /  J306G
宴会餐炉

宴会汤炉
J303

> Round Glass Lid Vision Soup Station
   dish, w/ss insert

> Round Steel Lid Vision Soup Station
   dish, w/ss insert

J303G
宴会汤炉

宴会餐炉
J304

> Oblong Glass Lid Vision Chafing 
   dish, w/ss insert

> Oblong Steel Lid Vision Chafing 
   dish, w/ss insert

J304G
宴会餐炉

标配酒精炉可选配电热板

> Round Glass/Steel Lid Vision  Chafing dish
> w/ss insert, With Stand and fuel holder

J401  /  J401G  /  J405  /  J405G
宴会餐炉

型号 容量 额定功率 额定电压 额定频率
J401/J401G 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板
最高温度≤ 100℃J405/J405G 4L 350W 220-240V~ 50/60HZ

J401/J401G J405/J405G

> Square Glass/Steel Lid Vision  Chafing dish
> w/ss insert, With Stand and fuel holder

J402  /  J402G  /  J406  /  J406G 
宴会餐炉

型号 容量 额定功率 额定电压 额定频率
J402/J402G 5.1L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板
最高温度≤ 100℃J406/J406G 3.8L 350W 220-240V~ 50/60HZ

J402/J402G J406/J406G

> Round Glass/Steel Lid Vision  Soup Station
> w/ss insert, With Stand and fuel holder

J403  /  J403G
宴会汤炉

型号 容量 额定功率 额定电压 额定频率
J403 12L 350W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板J403G 12L 350W 220-240V~ 50/60HZ

J403 J403G

> Oblong Glass/Steel Lid Vision Chafing dish
> w/ss insert, With Stand and fuel holder

J404  /  J404G
宴会餐炉

型号 容量 额定功率 额定电压 额定频率
J404 8.3L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板J404G 8.3L 500W 220-240V~ 50/60HZ

J404
J404G
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

J
系

列

J
系

列

J SERIES J SERIES（系列）
标配酒精炉可选配电热板 标配酒精炉可选配电热板

> Round Glass/Steel Lid Chafing dish
> 38cm s/s food insert

J601  /  J601G
宴会餐炉

型号 容量 额定功率 额定电压 额定频率
J601 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ 专用电热板J601G 6L 500W 220-240V~ 50/60HZ

J601 J601G

> Square Glass/Steel Lid Chafing dish
> 2/3 s/s food insert

J602  /  J602G
宴会餐炉

型号 容量 额定功率 额定电压 额定频率
J602 5.1L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ 专用电热板J602G 5.1L 500W 220-240V~ 50/60HZ

J602 J602G

> Square GN 1/2 Glass/Steel Lid Vision  Chafing dish
> w/ss insert, With stand and fuel holder

J606  /  J606G

J606

1/2 1/2

J606G

宴会餐炉

型号 容量 额定功率 额定电压 额定频率
J606 3.8L 350W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-350RJ 专用电热板
最高温度≥ 100℃J606G 3.8L 350W 220-240V~ 50/60HZ

J606 J606G

> Round Glass/Steel Lid Soup Station

J603  /  J603G
宴会汤炉

型号 容量 额定功率 额定电压 额定频率
J603 12L 350W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-350RJ 专用电热板
最高温度≤ 100℃J603G 12L 350W 220-240V~ 50/60HZ

J603 J603G

> Oblong Glass/Steel Lid Chafing dish
> 1/1 s/s food insert

J604  /  J604G
宴会餐炉

型号 容量 额定功率 额定电压 额定频率
J604 8.3L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ 专用电热板
最高温度≤ 100℃J604G 8.3L 500W 220-240V~ 50/60HZ

J604 J604G

> Round 30cm Glass/Steel Lid Vision  Chafing dish
> w/SS insert, With stand and fuel holder

J605  /  J605G
宴会餐炉

型号 容量 额定功率 额定电压 额定频率
J605 4L 350W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-350RJ 专用电热板
最高温度≥ 100℃J605G 4L 350W 220-240V~ 50/60HZ

J605 J605G

> Stand for Round 
   30cm/38cm Chafing Dish

> Stand for Mini Square GN 1/2 Chafing Dish
> Stand for Square GN 2/3 Chafing Dish

圆形框架 方形框架
C70  /  C80 C90  /  C100

> Stand for Oblong GN 1/1 
   Chafing Dish

长方形框架
C104

型号 额定电压 额定频率
DB-350RJ 220-240V~ 50/60HZ 适用 10A 国际插头

最高温度≥ 100℃DB-500RJ 220-240V~ 50/60HZ

> Electrical Heating Plate > Soup Bucket 12L 

调温电热板用餐炉12L 汤桶
DB-350RJ  /  DB-500RJ6011
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CHAFING DISH  餐
炉

类
 调

温
TC-S

系
列

CHAFING DISH  餐
炉

类
宴

会
餐

炉

> Clam Chafer
> Steel Lid

> Soup Station

C101

C2607

宴会餐炉

宴会餐炉

型号 尺寸 额定功率 额定电压 额定频率
C101 480*445*290 500W 220-240V~ 50/60HZ 适用 10A 国际插头

配专用 DB-500RJ 电热板C2607 480*445*290 500W 220-240V~ 50/60HZ

手柄
线条简约、造型优美

档水槽
全新设计贝壳系列产品，
增添挡槽，防止凝水外溢。

海星脚架
锤点工艺海星脚架，可选配电磁炉或
电热板，搭配贝壳餐炉更加完美。

Simple and elegant lines

餐炉盖
独特贝壳造型设计，
感触自然气息

Unique clam design, Feelings of 
natural flavor

The water vapor will back to the 
water pan via the water through

The starfish tripod, and optional 
buffet induction or electric warmer.

CLAM CHFING DISH
贝壳餐炉
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CHAFING DISH  餐
炉
类

宴
会

餐
炉
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CHAFING DISH  餐
炉

类
宴

会
餐

炉

J SERIES 标配酒精炉可选配电热板

> Chafing dish
> Round 38cm/30cm
> Glass / Steel Lid

J201  /  J201G
J205  /  J205G
宴会餐炉

型号 容量 额定功率 额定电压 额定频率
J201/J201G 6L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板J205/J205G 4L 350W 220-240V~ 50/60HZ

J201/J205 J201G/J205G

> Chafing dish
> GN2/3 / GN1/2
> Glass/Steel lid

J202  /  J202G
J206  /  J206G
宴会餐炉

型号 容量 额定功率 额定电压 额定频率
J202/J202G 5.1L 500W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ/350RJ 专用电热板J206/J206G 3.8L 350W 220-240V~ 50/60HZ

J202/J206 J202G/J206G

宴会餐炉宴会餐炉宴会汤炉

型号 容量 额定功率 额定电压 额定频率
J203G 3.8L 350W 220-240V~ 50/60HZ 适用 10A 国际插头

适合 DB-500RJ 专用电热板
最高温度≤ 100℃ J204/J204G 3.8L 350W 220-240V~ 50/60HZ

> Soup Station > Chafing dish
> 1/1 GN Glass Lid
> With stand
> 1/1 GN Glass Lid

> Chafing dish
> 1/1 GN Steel Lid
> With Stand

J203G J204 J204G

> Round Frame > Square Frame

C20  /  C30  /  C30-1 C40  /  C50  /  C60
圆形蝶菲框 方形蝶菲框 

挡水槽
全新改良蝶菲系列产品，增添挡水
槽，防止凝水外溢。

加厚板材
使用加厚的优质不锈钢板材，抗碰
撞，不易变形。

液压转轴
使用新型的液压转轴，具有防疲劳
设计，造型简洁美观；转轴的液压
压力可按需在出厂前随意调节。

Hinge mechanism guarantees 
slow down and durable open 
and closing.

The water vapor will back to the 
water pan via the water through.

Increase S/S thickness, 
reinforce and stronger.

> With Stand

> With Stand
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

碟
菲

系
列

碟
菲

系
列

D SERIES D SERIES（系列） （系列）

> Round Chafer 38cm 
with black 6L

> Round Chafer 38cm 
with gold 6L

B101G
镀黑金蹀菲餐炉

K101G
镀黄金蹀菲餐炉

> Round Black Chafing 
Dish 38cm 6L

> Round Gold Chafing 
Dish 38cm 6L

D101G-BK
圆形黑色餐炉

D101G-GD
圆形金色餐炉

> Square Black Chafing 
Dish 2/3 GN 5.1L

> Round Rose Gold 
Chafing Dish 38cm 6L

D102G-BK
方形黑色餐炉

D101G-RS
圆形金色餐炉

> Square Gold Chafing 
Dish 2/3 GN 5.1L

> Square Rose Gold 
Chafing Dish 2/3 GN 5.1L

D102G-GD
方形金色餐炉

D102G-RS
方形玫瑰金色餐炉

> Chafer / Glass Lid
> Round 38cm/30cm

> Round Chafer 38cm/30cm 
> Steel Lid

D101 / D105 
蝶菲餐炉（玻璃盖）

D101G / D105G
蝶菲餐炉（钢盖）

> 2/3 GN Chafer / Glass Lid
> 1/2 GN Chafer / Glass Lid

> 2/3 GN Chafer / Steel Lid
> 1/2 GN Chafer / Steel Lid

D102  /  D106
碟菲餐炉

D102G / D106G
碟菲餐炉

> Soup station 10L > Induction 1/1 GN 
Chafer/ Glass Lid 8L

D103
碟菲汤炉

D104
长方形碟菲餐炉

> Induction 1/1 GN 
Chafer / Steel Lid 8L

D104G
长方形碟菲餐炉

> Chafing dish
> GN 2/3
> Glass / Gold Color

KJ202
宴会餐炉

> Square 2/3 Glass Lid Vision
Chafing Dish / Gold Color

> w/ss insert with electric heater

KJ1002
方形餐炉 / 玻璃盖
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

碟
菲

系
列

碟
菲

系
列

D/J SERIES J SERIES（系列） （系列）

> Chafer / Steel Lid
> Electrical
> Round 38cm

> 2/3 GN Chafer
> Glass Lid
> Electrical

D201G D202
碟菲餐炉 碟菲餐炉

型号 容量 额定功率 额定电压 额定频率
D201G 6L 280W 220-240V~ 50/60HZ 配 DB-280
D202 5.1L 280W 220-240V~ 50/60HZ 配 DB-280

> Chafer / Glass Lid
> Electrical
> Round 38cm

> 2/3 GN Chafer / Steel Lid
> Electrical

D201 D202G
碟菲餐炉 碟菲餐炉

型号 容量 额定功率 额定电压 额定频率
D201 6L 280W 220-240V~ 50/60HZ 配 DB-280
D202G 5.1L 280W 220-240V~ 50/60HZ 配 DB-280

> Soup Station 10L > 1/1 GN Chafer
> Glass / Lid
> Electrical

D203G D204
碟菲汤炉 碟菲汤炉

型号 容量 额定功率 额定电压 额定频率
D203G 10L 280W 220-240V~ 50/60HZ 配 DB-280
D204 8.3L 280W 220-240V~ 50/60HZ 配 DB-280

> Electrical 1/1 GN Chafer
> Steel Lid

> Sout Station

D204G J103G
宴会餐炉 全钢圆形汤炉 / 钢盖

型号 容量 额定功率 额定电压 额定频率
D204 8.3L 280W 220-240V~ 50/60HZ 配 DB-280

适用 10A 国标插头J103G 10L 280W 220-240V~ 50/60HZ

J103G

标配酒精炉可选配电热板

> Round Chafing Dish 
> s.s Leg
> Glass Lid

> Round Chafing Dish 
> s.s Leg
> Steel Lid

J101 J101G
全钢圆形餐炉 / 玻璃盖 全钢圆形餐炉 / 钢盖

型号 容量 额定功率 额定电压 额定频率
J101 6L 380W 220-240V~ 50/60HZ

配 DB-280 适用 10A 国际插头
J101G 6L 380W 220-240V~ 50/60HZ

> 2/3 GN Chafer Dish 
> s.s Leg
> Glass Lid

> 2/3 GN Chafer Dish 
> s.s Leg
> Steel Lid

J102 J102G
全钢方形餐炉 / 玻璃盖 全钢方形餐炉 / 钢盖

型号 容量 额定功率 额定电压 额定频率
J102 5.1L 380W 220-240V~ 50/60HZ

配 DB-380 适用 10A 国际插头
J102G 5.1L 380W 220-240V~ 50/60HZ

> 1/1 GN Chafing Dish 
> s.s Leg
> Glass Lid

> 1/1 GN Chafing Dish 
> s.s Leg
> Steel Lid

J104 J104G
全钢长方形餐炉 / 玻璃盖 全钢长方形餐炉 / 钢盖

型号 容量 额定功率 额定电压 额定频率
J104 8.3L 280W 220-240V~ 50/60HZ

配 DB-280 适用 10A 国际插头
J104G 8.3L 380W 220-240V~ 50/60HZ

型号 额定功率 额定电压 额定频率
DB-180/DB-180A 180W 220-240V~ 50/60HZ

适用 10A 国际插头
DB-700 700W 220-240V~ 50/60HZ
DB-200A 200W 220-240V~ 50/60HZ
DB-280/DB-280D 280W 220-240V~ 50/60HZ
DB-380 380W 220-240V~ 50/60HZ

DB-200A
加长电热板

DB-380
电热板

DB-180
电热板

DB-700
调温电热板

DB-280D
电热板

DB-280
电热板
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

配
件

系
列

配
件

系
列

> Double heads chafing dish 
with control temperature

> Chafing Dish With control 
Temperature(Left)

TC20 TC10L
可调温双头宴会餐炉 温控宴会汤炉

型号 容量 额定功率 额定电压 额定频率
TC20 6L*2 250W*2 220-240V~ 50/60HZ 适用 10A 国标插头
TC10L 10L 250W 220-240V~ 50/60HZ 适用 10A 国标插头

TC SERIES ACCESSORIES SERIES（系列） （系列）

> Triple heads chafing dish 
with control temperature

> Chafing Dish With control 
Temperature(right)

TC30 TC10R
可调温三头宴会餐炉 温控宴会汤炉

型号 容量 额定功率 额定电压 额定频率
TC30 6L*3 250W*2 220-240V~ 50/60HZ 适用 10A 国标插头
TC10R 10L 250W 220-240V~ 50/60HZ 适用 10A 国标插头

> 1/3 Porcelain Insert

> GN2/3 Porcelain Insert

> Round 38cm Porcelain Insert

> 1/1 Porcelain Insert

> GN1/2 Porcelain Insert

D13

D30

D70

D70B

D10

D60

D70S

D80

1/3 瓷盘

2/3 方瓷盘

300 小圆瓷盘

300 小圆直格瓷盘

380 圆瓷盘

1/1 长方形瓷盘

300 小圆 S 格瓷盘

1/2 小方瓷盘

>Round 38cm  Diveided 
Porcelain Insert

D20
双格圆瓷盘

> Round 38cm Porcelain 
Insert  "S" divided

D10S
双格 S 形瓷盘

按需搭配 组合简易

ACCORDING TO THE NEEDS 
OF THE COMBINATION OF 
SIMPLE

采用高性能单片计算机作为智
能核心控制部件。

High performance monolithic 
computer is used as the 
intelligent core control 
component. 数码温度显示，保温温度一目

了然。

Digital temperature display, 
insulation temperature at a 
glance.

设计温度记忆功能，当关机后
再重新开机，则设定温度保持
上一次关机时的设定温度，无
需再次设定。

Temperature memory function 
is designed. When the machine 
is turned off and restarted, the 
set temperature remains the 
same as the set temperature 
when the machine was turned 
off last time. There is no need to 
set it again.

全自动恒温模式，恒温精度高，
保温温度可在 40° C 到 95° C 之
间任意调节，也可选择不保温，
以满足特殊食物的需要。

Automatic constant 
temperature mode, high 
constant temperature accuracy, 
thermal insulation temperature 
can be adjusted from 40°C 
to 95°C, also can choose no 
thermal insulation, to meet the 
needs of special food.

全自动保护功能，当温度传感
器测温不正常时会自动停止加
热，且给出错误代码。

Automatic protection function, 
when the temperature sensor 
temperature measurement is 
not normal, it will automatically 
stop heating, and give the error 
code.

触摸按键，防水且便于清洁。

Touch button, waterproof and 
easy to clean.

> Round 30cm Porcelain Insert > Round 30cm Porcelain Insert
"s" divided

> Round 30cm Porcelain 
Insert divided
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CHAFING DISH  餐
炉
类

CHAFING DISH  餐
炉
类

透
明

半
翻

盖
系

列

配
件

系
列

ACCESSORIES SERIES S SERIES（系列） （系列）

> Round 38cm aluminum plate > Square GN2/3 aluminum plate

A10 A30
380 圆铝盘 2/3 铝盘

> Square GN1/2  aluminum plate

A70 A80
300 圆铝盘 1/2 方铝盘

> Round Frame > Squarea Frame

D40 D50
圆形框架 方形框架

> Round Chafing Dish 
> s.s Leg
> PC Cover

> Rect Chafer Dish 
> s.s Leg
> PC Cover

J2522 J2502
全钢透明盖圆形餐炉 全钢透明盖方形餐炉

型号 容量 额定功率 额定电压 额定频率
J2522 6L 380W 220-240V~ 50/60HZ 配 DB-280 适用 10A 国标插头
J2502 8.3L 380W 220-240V~ 50/60HZ 配 DB-280 适用 10A 国标插头

> Round Half Roll-top Chafing 
Dish with Electric plate

> PC Cover

> Oblong Chafing Dish with 
Electric plate

> PC Cover

S2302/20  |  S2302/40
S2302/60

S2201/20  |  S2201/40
S2201/60

带电透明半翻盖宴会餐炉 全钢透明盖方形餐炉

> Chafing Dish > Chafing Dish with electric 
plate 

S2201/20J  |  S2201/40J
S2201/60J

SD2201/20J  |  SD2201/40J
SD2201/60J

透明罩宴会餐炉 透明罩宴会餐炉（带电）

> Roll-top Chafing Dish with 
Electric plate

> PC Cover

> Oblong Chafing Dish with 
Electric plate

> PC Cover

SD2302/20  |  SD2302/40
SD2302/60

SD2201/20  |  SD2201/40
SD2201/60

带电透明半翻盖宴会餐炉 全钢透明盖方形餐炉

型号 额定功率 额定电压 额定频率
SD2302/20 | SD2302/40 | SD2302/60 250W 220-240V~ 50/60HZ 配 DB-200A

适用 10A 国标插头SD2201/20 | SD2201/40 | SD2201/60 250W 220-240V~ 50/60HZ

型号 容量 额定功率 额定电压 额定频率
SD2511 6L 250W 220-240V~ 50/60HZ 配 DB-200A 适用 10A 国标插头
SD2501 8.3L 250W 220-240V~ 50/60HZ 配 DB-200A 适用 10A 国标插头

> Round Chafing 
> Electric plate
> PC Cover

> Oblong Chafing Dish with 
Electric plate

> PC Cover

S2511

SD2511 SD2501

透明半翻盖宴会餐炉

带电透明半翻盖宴会餐炉 带电透明半翻盖宴会餐炉

> Round 30cm aluminum plate
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我们生产的不止是容器
更是品质餐饮的氛围缔造者

OTHER SERIES
其它类

CREATOR OF THE ATMOSPHERE
MAKER
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OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

蒸
笼
系
列

蒸
笼
系
列

> Bamboo steamer lid > Bamboo steamer

B001 B002
竹笼盖 竹笼底

STEAM OVEN SERIES（蒸炉系列）

> Round water pan > Adaptor for steamer

DC20 6010
圆水盘 圆形带孔面板

有孔圆面板，可以直接把水蒸气回
流到积水盘里，防止凝水外溢。

> Triple Steamer

TC30（STEAM）
> Round steamer

D201（STEAM）
碟菲蒸炉 可调温三头宴会蒸炉

型号 额定功率 额定电压 额定频率

D201 700W 220-240V~ 50/60HZ 适用 10A
国际插头

型号 额定功率 额定电压 额定频率 可调温度

TC30 250WX3 220-240V~ 50/60HZ 40-95℃ 适用 10A
国际插头
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OTHER SERIES  其
他

类

OTHER SERIES  其
他

类

电
热

快
餐

保
温

炉
系

列

红
酒

喷
泉

系
列

SEAFOOD TOWER SERIES 海鲜塔系列

3004A 四层豪华海鲜塔

3004B 四层全钢海鲜塔

> Wine Fountain

WF001

> 4-Tiers Buffet Stand

3004A/3004B
四层豪华海鲜塔 / 四层全钢海鲜塔

红酒喷泉

额定功率 额定电压 额定频率
1200W 220-240V~ 50/60HZ 适用 10A 国际插头

ELECTRIC FAST FOOD HOLDING FURNACE SERIES 
电热快餐保温炉系列

> 77 Electrical Fast Food
> Warming Oven
> 1200W/100-240V

额定功率 额定电压 额定频率
1200W 220-240V~ 50/60HZ 适用 10A 国际插头

D7726
77 型 6 格电热快餐炉

> 77 Electrical Fast Food
> Warming Oven
> 1200W/100-240V

> 77 Electrical Fast Food
> Warming Oven
> 1200W/100-240V

额定功率 额定电压 额定频率
1200W 220-240V~ 50/60HZ 适用 10A 国际插头

容量 额定功率 额定电压 额定频率
12.5L 1200W 220-240V~ 50/60HZ 适用 10A 国际插头

D7700 D7701
77 型电热快餐保温炉 77 型电热快餐保温炉

> 77 Electrical Fast Food
> Warming Oven
> 1200W/100-240V

> 77 Electrical Fast Food
> Warming Oven
> 1200W/100-240V

容量 额定功率 额定电压 额定频率
3.3LX3 1200W 220-240V~ 50/60HZ 适用 10A 国际插头

容量 额定功率 额定电压 额定频率
5.5LX2 1200W 220-240V~ 50/60HZ 适用 10A 国际插头

D7702/ 双格 D7703
77 型电热快餐保温炉 77 型电热快餐保温炉

> 77 Electrical Fast Food
> Warming Oven
> 1200W/100-240V

> 77 Electrical Fast Food
> Warming Oven
> 1200W/100-240V

额定功率 额定电压 额定频率
1200W 220-240V~ 50/60HZ 适用 10A 国际插头

容量 额定功率 额定电压 额定频率
7LX2 1200W 220-240V~ 50/60HZ 适用 10A 国际插头

D7706 D7720
77 型电热什锦炉 77 型电热快餐保温汤炉
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OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

餐
车

/ 麦
片

机
系

列

巧
克

力
喷

泉

额定功率 额定电压 额定频率
350W 220-240V~ 50/60HZ 适用 10A 国际插头

> Chocolate fountain/6KG

CP-60
巧克力喷泉

额定功率 额定电压 额定频率
350W 220-240V~ 50/60HZ 适用 10A 国际插头

> Chocolate fountain/8KG

CP-80
巧克力喷泉

额定功率 额定电压 额定频率
350W 220-240V~ 50/60HZ 适用 10A 国际插头

> Chocolate fountain/4KG

CP-40
巧克力喷泉 SERVICE WAGON

CEREAL DISPENSERS

餐车系列

麦片器系列

> Contiental Roast
Beef Service Wagon

W-0101
双层豪华型烤牛肉车

> Single Cereal Dispenser 3.6L
> Wooden Stand

> Single Cereal Dispenser 3.6LX2
> Wooden Stand

> Single Cereal Dispenser 3.6LX3
> Wooden Stand

W36301
单头麦片器（BPA FREE）

> Contiental Roast
Beef Service Wagon

W-0102
双层豪华型烤牛肉车

W36302
双头麦片器（BPA FREE）

> Contiental Roast
Beef Service Wagon

W-0103
双层豪华型烤牛肉车

W36303
三头麦片器（BPA FREE）
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OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

果
汁

鼎
系

列

麦
片

机
系

列

CEREAL DISPENSERS JUICE DISPENSERS麦片器系列 果汁鼎系列

W36401
单头果汁鼎（BPA FREE）

W36402
双头果汁鼎（BPA FREE）

W36403
三头果汁鼎（BPA FREE）

> Single Juice Dispenser 3.6L
> Wooden Stand

> Double Juice Dispenser 3.6LX2
> Wooden Stand

> Triple Juice Dispenser 3.6LX3
> Wooden Stand

36301-2
单头麦片器 3.6L（BPA FREE）

36302-2
双头麦片器 3.6LX2（BPA FREE）

36303-2
三头麦片器 3.6LX3（BPA FREE）

> Single Cereal Dispenser 3.6L > Double Cereal Dispenser 3.6LX2 > Triple Cereal Dispenser 3.6LX3

> Cereal Dispenser
> 10L

> Cereal Dispenser/Double
> 10LX2

> Cereal Dispenser/Triple
> 10LX3

10304
单头麦片器 10L

10305
双头麦片器 10LX2

10306
三头麦片器 10LX3

> Cereal Dispenser 
> 10L

10301
单头麦片器 10L

> Cereal Dispenser/Double 
> 10Lx2

10302
双头麦片器 10X2

36401-2
单头果汁鼎（BPA FREE）

36402-2
双头果汁鼎（BPA FREE）

36403-2
三头果汁鼎（BPA FREE）

> Single Juice Dispenser 3.6L
> Wooden Stand

> Double Juice Dispenser 3.6LX2
> Wooden Stand

> Triple Juice Dispenser 3.6LX3
> Wooden Stand

F10401-2 EB10401 36406 36306
单头果汁鼎 / 带孔冰管 8L 单头电热果汁鼎  8L

可选用 DB-180A 电热板

三头旋转果汁鼎 三头旋转麦片器

> Single Juice Dispenser
> infusion 8L

> Single Juice Dispenser
> Heating plate 180W 8L

> Triple Juice Dispenser 3.6LX3 > Triple Cereal Dispenser 3.6LX3
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JUICE DISPENSERS 果汁鼎系列

C12401  /  C12401G
5 升单联果汁鼎 ( 镀金）（镀铬 )

5 升单联果汁鼎 ( 镀金）（镀铬 )

6 升双联果汁鼎 ( 镀金）（镀铬 )

C12402  /  C12402G

C12401-2  /  C12401G-2
> Juice Dispenser
> 5L

> Juice Dispenser
> 5L

> Juice Dispenser
> 5LX2

C12403  /  C12403G
5 升单联果汁鼎 ( 镀金）（镀铬 )

5 升单联果汁鼎 ( 镀金）（镀铬 )

5 升双联果汁鼎 ( 镀金）（镀铬 )

C12404  /  C12404G

C12403-2  /  C12403G-2
> Polygonal Juice Dispenser
> 6L

> Polygonal Juice Dispenser
> 5L

> Juice Dispenser
> 6LX2

S12401  /  S12401G S12401-2  /  S12401G-2
5 升单联果汁鼎 ( 镀金）（镀铬 ) 5 升双联果汁鼎 ( 镀金）（镀铬 )
> Polygonal Juice Dispenser
> 5L

> Polygonal Juice Dispenser
> 5LX2

可选购旋转底盘，使用更方便。

Rotary chassis can be purchased for more 
convenient use.

罗马柱造型设计
造型优雅、豪华大方

Modeling design of Roman column 
Elegant and luxurious

特有的滴水槽设计，易拆装，
清洗更方便。

Special drip trough design, 
Easy to disassemble and clean.
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系
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B10402
全钢双连果汁鼎 /11L
> Juice Dispenser
> 2/11L

10402-1

10403-1

镀金双连果汁鼎 6Lx2

镀金三连果汁鼎 8Lx3

全钢双连果汁鼎 6Lx2 多角形果汁鼎 /11L
10402-2 J10401

> Polygonal Juice Dispenser
> 6Lx2

> Polygonal Juice Dispenser
> 6Lx3

> Polygonal Juice Dispenser
> 6Lx2

> Juice Dispenser
> 11L

镀金单连果汁鼎 全钢单连果汁鼎
C10401-1 C10401-2
> Juice Dispenser
> 6L

> Juice Dispenser
> 6L

B10401
全钢单连果汁鼎
> Polygonal Juice Dispenser
> 6L

10401-1
镀金单连果汁鼎 /8L
> Juice Dispenser
> 6L

全钢单连果汁鼎 /8L
A10401
> Juice Dispenser
> 6L

全钢单连果汁鼎 /8L
10401-2
> Juice Dispenser
> 6L

全钢三连果汁鼎 8Lx3
10403-2
> Polygonal Juice Dispenser
> 6Lx3

独有冰槽设计
连体设计，并带有独有冰
槽设计，让饮品持久保鲜。

后背特有的排水孔设计
便于冰水排出，方便实用，操作简单。

Particular tube design, 
keep fresh lasting.

Drainage in the back, easy to following the cooling water out. 
Convenient and useful, easy to use.

JUICE SERIES（系列）

> Juice Dispenser
> 6L

> Juice Dispenser
> 6L

2580G-9E 19401G
果汁鼎 果汁鼎

> Juice Dispenser
> 15L

19401-15
果汁鼎

> Juice Dispenser
> 10L

19401-10
果汁鼎

19402
全钢单连果汁鼎

> Polygonal Juice Dispenser
> 10L

果
汁

鼎
系

列
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JUICE SERIES（系列）

> Wooden frame Juice 
   Dispenser
> 5L

> Wooden frame Juice 
   Dispenser
> 9L

> Wooden frame Juice 
   Dispenser
> 6L

> Wooden frame Juice 
   Dispenser
> 13L

W19401-5

W19401-9

W19401-6

W19401-13

木框果汁鼎

木框果汁鼎

木框果汁鼎

木框果汁鼎

JUICE SERIES（系列）

> Stainless steel base 
   Juice Dispenser
> 10L

> Stainless steel base 
   Juice Dispenser
> 10L

F19401-10 F19401-10B
不锈钢底座果汁鼎

> Stainless steel base 
   Juice Dispenser
> 15L

F19401-15
不锈钢底座果汁鼎

不锈钢喷漆底座果汁鼎

> Stainless steel base 
   Juice Dispenser
> 15L

F19401-15B
不锈钢喷漆底座果汁鼎

果
汁

鼎
系

列

果
汁

鼎
系

列
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COFFEE DISPENER SERIES 咖啡鼎系列
标配酒精炉 可选配电热板

10501
镀金鼓形咖啡鼎 /8L 镀金咖啡暖鼎 /7L 镀金咖啡暖鼎 /10L

10701 10801

> Brass-plated 
Coffee dispenser

> 8L

> Brass-plated 
Coffee dispenser

> 7L

> Brass-plated 
Coffee dispenser

> 10L

型号 额定功率 额定电压 额定频率
10501 180W 220-240V~ 50/60HZ

适用 10A 国际插头
适用 DB-180A 专用电热板10701 180W 220-240V~ 50/60HZ

10801 180W 220-240V~ 50/60HZ

10501G
全钢鼓形咖啡鼎 /8L 全钢咖啡暖鼎 /7L 全钢咖啡暖鼎 /10L

10701G 10801G

> Stainless Steel 
Coffee dispenser

> 8L

> Stainless Steel 
Coffee dispenser

> 7L

> Stainless Steel 
Coffee dispenser

> 10L

型号 额定功率 额定电压 额定频率
10501G 180W 220-240V~ 50/60HZ

适用 10A 国际插头
适用 DB-180A 专用电热板10701G 180W 220-240V~ 50/60HZ

10801G 180W 220-240V~ 50/60HZ

JUICE SERIES（系列）

> Stainless steel hollow 
base stand Juice Dispenser

> 10L

F19401H-10 F19401H-10B
不锈钢镂空底座果汁鼎 不锈钢镂空喷漆底座果汁鼎

> Stainless steel hollow 
base stand Juice Dispenser

> 15L

> Stainless steel hollow 
base stand Juice Dispenser

> 15L

F19401H-15 F19401H-15B
不锈钢镂空底座果汁鼎 不锈钢镂空喷漆底座果汁鼎

> Stainless steel hollow 
base stand Juice Dispenser

> 10L

果
汁

鼎
系

列

果
汁

鼎
系

列
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咖
啡

鼎
系

列

全钢鼓形咖啡鼎 /8L 全钢咖啡鼎 /10L 全钢咖啡鼎 /7L
10502 10802 10702
> Stainess-Stell 

Coffee dispenser
> 8L

> Stainess-Stell 
Coffee dispenser

> 10L

> Stainess-Stell 
Coffee dispenser

> 7L

型号 额定功率 额定电压 额定频率
10502 180W 220-240V~ 50/60HZ

适用 10A 国际插头
适用 DB-180A 专用电热板10702 180W 220-240V~ 50/60HZ

10802 180W 220-240V~ 50/60HZ

全钢咖啡鼎 /8L 全钢咖啡鼎 8L
10901L 10902
> Stainess-Stell 

Coffee dispenser
> 8L

> Stainess-Stell 
Coffee dispenser

> 8L

双层保温咖啡鼎 /12L
J10801B

·具有四小时保温功能，
无需电和酒精加热。

> Coffee um with 
double wall

> 12L

型号 额定功率 额定电压 额定频率
10901L 180W 220-240V~ 50/60HZ 适用 10A 国际插头

适用 DB-180A 专用电热板10902 180W 220-240V~ 50/60HZ

双层保温咖啡鼎 /12L
J10801

·具有四小时保温功能，
无需电和酒精加热。

> Coffee um with 
double wall

> 12L

全钢咖啡鼎（无加热功能）/8L
10602
> Stainess-Stell 

Coffee dispenser
(No heatting function)
> 8L

镀金咖啡鼎（无加热功能）/8L
10601
> Brass-piated

Coffee dispenser
(No heatting function)
> 8L

标配酒精炉 可选配电热板

双层保温咖啡鼎 /12L
Z10801

·具有四小时保温功能，
无需电和酒精加热。

> Coffee um with 
double wall

> 12L

> Stainless steel Coffee 
Dispenser

> Stainless steel Coffee 
Dispenser

2581K-9E 19901G
咖啡鼎 咖啡鼎

型号 容量 额定功率 额定电压 额定频率
2581K-9E 7L 180W 220-240V~ 50/60HZ 适用 DB-180A 专用电热板

适用 10A 国际插头19901G 7L 180W 220-240V~ 50/60HZ

COFFEE SERIES（系列）

全钢咖啡暖鼎 /10L
10903

> Stainless Steel 
Coffee dispenser

> 10L

全钢牛奶暖鼎 /11L
10904

> Stainless Steel 
Coffee dispenser

> 11L
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INDUCTION SERIES 电磁炉系列

电磁炉
EB-1200

电磁炉开孔图

额定功率 额定电压 额定频率
2100W 220-240V~ 50/60HZ 适用 10A 国际插头

> Buffet Induction

额定功率 额定电压 额定频率
3600W 220-240V~ 50/60HZ 适用 10A 国际插头

额定功率 额定电压 额定频率
1800W 220-240V~ 50/60HZ 适用 10A 国际插头

CF-3600 EB-2400
双头光波炉 双头电磁炉
>  Infared Cooker Double > Buffet Induction Double

CF-1800
光波炉 电磁炉 800W 圆电磁炉

EB-450A EB-450B
> Infared Cooker > Induction Cooker > Induction Cooker

型号 额定功率 额定电压 额定频率
CF-1800 1800W 220-240V~ 50/60HZ

适用 10A 国际插头EB-450A 450W 220-240V~ 50/60HZ
EB-450B ≤ 800W 220-240V~ 50/60HZ

> Square glass
   warming tray

> Rectangle glass
   warming tray

额定功率 额定电压 额定频率
350W 220-240V~ 50/60HZ 适用 10A 国际插头

额定功率 额定电压 额定频率
300W 220-240V~ 50/60HZ 适用 10A 国际插头

HG1313 HG2113
玻璃保温台 玻璃保温台

> Square glass
   warming tray

> Rectangle glass
   warming tray

额定功率 额定电压 额定频率
1800W 220-240V~ 50/60HZ 适用 10A 国际插头

额定功率 额定电压 额定频率
50W 220-240V~ 50/60HZ 适用 10A 国际插头

HG0707 HG1407
玻璃保温台 玻璃保温台

电磁炉
MEB-1200
> Buffet Induction
> 5L
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WARMING TRAY SERIES 保温台系列

> Rectangle glass
   warming tray

额定功率 额定电压 额定频率
350W 220-240V~ 50/60HZ 适用 10A 国际插头

额定功率 额定电压 额定频率
300W 220-240V~ 50/60HZ 适用 10A 国际插头

HG2113Q

> Square glass
warming tray

HG1313Q
嵌入式玻璃保温台

嵌入式玻璃保温台

> Rectangle glass
Built-in warming tray

额定功率 额定电压 额定频率
1KW 220-240V~ 50/60HZ 适用 10A 国际插头

HG1901Q
嵌入式玻璃保温台

L 1260 D 498

> Rectangle glass
   warming tray

额定功率 额定电压 额定频率
1KW 220-240V~ 50/60HZ 适用 10A 国际插头

HG1901QC
嵌入式玻璃保温台

备注：不包括台面

542
542
569

1.
5

37
7

37
7

40
4

377
377
404

1.
5

34
2

34
2

36
9
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1239
182

92

72

37

27

477

1350 460

800

515
770

1440

L 1440 D 800 H 1285
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MIRROR PLATE SERIES 镜盘镜台系列

Round Plate
无柄圆形镜面盘 无柄方形镜面盘

Oblong Tray
无柄椭圆形镜面盘
Oval Plate

型号 A( 含柄 ) H
880122 560 20
870120 515 20
860118 480 20

型号 A( 无柄 ) B H
880222 560 420 20
870220 520 370 20
860218 475 325 20

型号 A( 无柄 ) B H
880322 575 445 20
870320 505 365 20
860318 460 320 20

Round Plate/W.Handles
连柄圆形镜面盘 连柄方形镜面盘

Oblong Tray/W.Handles
连柄椭圆形镜面盘
Oval Plate/W.Handles

型号 A( 无柄 ) B H
880122-1 670 560 38
870120-1 625 515 38
860118-1 590 480 38

型号 A( 无柄 ) B H
880222-1 670 420 38
870220-1 630 370 38
860218-1 585 325 38

型号 A( 无柄 ) B H
880322-1 665 445 38
870320-1 600 365 38
860318-1 550 320 38

Round Plate/W.Handles
叠柄圆形镜面盘 叠柄方形镜面盘

Oblong Tray/W.Handles
叠柄椭圆形镜面盘
Oval Plate/W.Handles

型号 A( 无柄 ) B H
880122-2 635 560 65
870120-2 585 510 65
860118-2 530 480 65

型号 A( 无柄 ) B H
880222-2 655 420 65
870220-2 580 370 65
860218-2 540 325 65

型号 A( 无柄 ) B H
880322-1 645 445 65
870320-1 560 365 65
860318-1 505 320 65

Round Plate/W.Handles
叠柄圆形镜面盘 叠柄方形镜面盘

Oblong Tray/W.Handles
叠柄椭圆形镜面盘
Oval Plate/W.Handles

型号 A( 无柄 ) B H
G880122-2 635 460 65
G870120-2 585 510 65
G860118-2 530 480 65

型号 A( 无柄 ) B H
G880222-2 655 420 65
G870220-2 580 370 65
G860218-2 540 325 65

型号 A( 无柄 ) B H
G880322-1 645 445 65
G870320-1 560 365 65
G860318-1 505 320 65

TRAY SERIES 镜盘镜台系列

全钢点心镜台镀金点心镜台
S8805S8804

方形有花镜台
4220B

圆形有花镜台
4020B
> Round Mirror Prate/Rose

全钢高脚水果盘

镀金点心镜台

G8530-2  /  G8540-2
G8550-2

S8806

> Compote With
Stainess Steel Leg

> KPL/D
> ALE Multiplex

全钢点心镜台
S8807
> KPL/D
> ALE Multiplex

镀金高脚水果盘

G8530-1  /  G8540-1
G8550-1
> Compote With Brass Leg

> Roll Top cover
> mirror plate
> gilt handle

> Roll Top cover
> mirror plate
> gilt handle

长方形有花镜台
4122B
> Oblong Mirror Prate/Rose

> Oblong Mirror Prate/Rose
椭圆形有花镜台
4322B
> Oblong Mirror Prate/Rose

六角形有花镜台
4424B
> Hxagon Mirror Prate/Rose

型号 A H
G8530-1 305 175
G8540-1 405 185
G8550-1 505 195

型号 A H
G8530-2 305 175
G8540-2 405 185
G8550-2 505 195
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ARTICLES SERIES用品系列

11

22

序号 型号 名称 描述 面板直径（长） 内孔直径（宽）
1 6606 圆形汤炉面板 Round Buffet Stand 380 220
2 6607 长方形汤炉面板 Oblong Buffet Stand 540 330

酒精炉
6004
> Lamp

扇形搁盘
6002

1L 双层冰桶
1001
> Ice Bucket

6005
方形搁盘
6001
> Service Tong Holder > Service Tong Holder

A  C H 容量
250 220 150 4.6L

5035/5045
不锈钢沙律盘
> Stainless Steel Punch Bowl
> 5L

ARTICLES SERIES 用品系列

6003-2
食物夹
> Tong

6003-1
汤更
> Deluxe Ladie

有孔炒更
6003-3
> Slotted Spoon

饭更
6003-4
> Spoon

6012
圆食物盘 315*65 圆食物盘 380*65 圆双格食物盘 380*65

6008 6009
> Staineless Steam Table Pans
> 4L

> Staineless Steam Table Pans
> 6L

> Round insert Divided
> 6L
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SOUP KETTLE SERIES 用品系列

600w 暖汤煲
D8002
> Soup Kettle
> 11L

600w 暖汤煲
D8001
> Soup Kettle
> 11L

600w 暖汤煲
D8004
> Soup Kettle
> 11L

600w 暖汤煲
D8005
> Soup Kettle
> 11L

600w 温度显示暖汤煲
Q19010
> Soup Kettle
> 11L

600w 暖汤煲
D9001-R
> Soup Kettle
> 11L

容量 额定功率 额定电压 额定频率
11L 800W 220-240V~ 50/60HZ 适用 10A 国际插头

容量 额定功率 额定电压 额定频率
11L 800W 220-240V~ 50/60HZ 适用 10A 国际插头

容量 额定功率 额定电压 额定频率
11L 600W 220-240V~ 50/60HZ 适用 10A 国际插头

容量 额定功率 额定电压 额定频率
10L 600W 220-240V~ 50/60HZ 适用 10A 国际插头

容量 额定功率 额定电压 额定频率
10L 600W 220-240V~ 50/60HZ 适用 10A 国际插头

> Soup Kettle
> 11L

D9001-Q
800w 嵌入式暖汤煲

嵌入式汤煲示意图

> Soup Kettle
> 11L

D9001-A
800w 暖汤煲
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OTHER SERIES  其
他

类
摆

件
系

列

OTHER SERIES  其
他

类
摆

件
系

列

BUFFET STAND 自助餐搁架

序号 型号 L W H

1
S1136-1 415 360 240
S1130-1 346 300 230

2 S1136-2 415 360 240
3 S1136-3 415 360 240
4 S1120-4 230 200 200
5 S1120-5 230 220 200
6 S1120-6 230 200 200

型号 L W H
G1054 1000 540 10
G8042 800 420 10
G6034 600 340 10
G4242 420 420 10

序号 型号 L W H

7
F1120-1 200 200 200
F1125-2 250 250 250
F1130-3 300 300 300

序号 型号 L W H

8
Y1120-1 230 230 140
Y1125-2 265 265 190
Y1130-3 300 300 240

Hex buffet stand

Hex buffet stand G6536 G6069 G6010

六角形搁架

六角形搁架 Fan-shaped glass  扇形玻璃 Glass plate /Hexagon 六角形玻璃 Round glass 圆形玻璃

Square buffet stand
方形搁架

Round buffet stand
圆形搁架

1 2 5 6

3 4 7 8
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BUFFET CORNER自助餐角柱

序号 型号 L W H
1 C11-12 120 120 120
2 C11-24 120 120 240
3 C11-36 120 120 360

Buffet cross "choice"

S4250 NG196 NG113

自助餐角柱

Three buffet tray rack
三层自助餐托盘架

Step glass
阶梯玻璃

Step glass
阶梯玻璃

1

2

3

3-TIER BUFFET CORNERS 3 层自助餐角柱

OTHER SERIES  其
他

类
摆

件
系

列

OTHER SERIES  其
他

类
摆

件
系

列
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序号 型号 L W H
1 M1120-1 256 256 470

M1120-1G 256 256 470
M1120-1RG 256 256 470

2 M1120-2 214 214 349
M1120-2G 214 214 349
M1120-2RG 214 214 349

3 M1120-3 256 256 227
M1120-3G 256 256 227
M1120-3RG 256 256 227

4 M1120-4 256 256 106
M1120-4G 256 256 106
M1120-4RG 256 256 106

序号 型号 L W H
A S4242 420 420 10
B S6042 600 420 10
C S6960H 693 600 10
D S6010C  Φ600 10

Manhattan/Buffet Stand Natural slate
曼哈顿层架 天然板岩2 2 21 1 1

A

3 3 34 4 4

D

MANHATTAN/BUFFET STAND/SKYLINE 曼哈顿层架 - 天际线

OTHER SERIES  其
他

类
摆

件
系

列

OTHER SERIES  其
他

类
摆

件
系

列

B

C
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OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

摆
件

系
列

摆
件

系
列

FOOD SHOWCASE 食物展示台

序号 型号 L W H
1 A1101-1 435 200 155

A1101-2 480 230 200
A1101-3 525 260 245

序号 型号 L W H
2 A1102-1 110 110 110

A1102-2 140 140 140
A1102-3 170 170 170
A1102-4 200 200 200
A1102-5 230 230 230
A1102-6 260 260 260

Trapezoidal combination Mirror

Square Showcase

梯形组合镜台

方形组合镜台

序号 型号 L W H
1 800140C 250 150 35

800141C 315 165 40
800142C 315 255 45

2 800143C 515 315 50

序号 型号 L W H
2 880150C 470 260 40

序号 型号 L W H
3 880160C 470 310 40

序号 型号 L W H
4 880170C 470 450 40

Square Plate

Simple combination on demand

Willow Plate

Small-S shaped Plate

Large-S shaped Plate

方形盘

柳叶盘

按需搭配 组合简易

小 S 型盘

大 S 型盘

COMBINATION BUFFET  PLATE 自助餐组合敲打盘

2

2

1

1

3

4
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OTHER SERIES  其
他

类

OTHER SERIES  其
他

类

摆
件

系
列

摆
件

系
列

序号 型号 L W H
6 880222C-1 670 420 38

870220C-1 630 370 38
860218C-1 585 325 38

序号 型号 L W H
10 880322C-1 665 445 38

870320C-1 600 365 38
860318C-1 550 320 38

序号 型号 L W H
11 G880322C-2 665 445 65

G870320C-2 600 365 65
G860318C-2 550 320 65

序号 型号 L W H
12 880322C-2 665 445 65

870320C-2 600 365 65
860318C-2 505 320 65

序号 型号 L W H
7 G880222C-2 655 420 65

G870220C-2 580 370 65
G860218C-2 540 325 65

序号 型号 L W H
8 880222C-2 655 420 65

870220C-2 580 370 65
860218C-2 540 325 65

序号 型号 L W H
3 G880122C-2 635 560 65

G870120C-2 585 515 65
G860118C-2 530 480 65

序号 型号 L W H
4 880122C-2 635 560 65

870120C-2 585 515 65
860118C-2 530 480 65

ART DE BUFFET造型盘

2

1

3

6

4

5

7

序号 型号 D H
1 A1107 250 85

Round Plate
圆型盘

序号 型号 L W H
2 A1108 185 185 80

Art Plate
艺术盘

序号 型号 D H
3 A1109 276 55

Round Plate
圆型盘

序号 型号 L W H
4 A1110 205 205 56

Art Plate
艺术盘

序号 型号 W H
5 A1112-1 390 240

A1112-2 500 260

Round Plate
沙律盘

序号 型号 W H
6 A1113 180 80

A1114 280 130

Round Bowl
圆型碗

序号 型号 W H
7 A1115 180 80

Round Bowl
圆型碗

1 3 5

2 4

6

6

7

9

11

8 10 12

Round Plate

Round Plate/W.Handles

Round Plate/W.Handles

Round Plate/W.Handles

无柄圆形镜面盘

连柄圆形镜面盘（镀金）

叠柄圆形镜面盘（镀铬）

叠柄圆形镜面盘（镀金）

序号 型号 D H
1 880122C 560 20

870120C 515 20
860118C 480 20

序号 型号 L W H
5 880222C 560 420 20

870220C 520 370 20
860218C 475 325 20

序号 型号 L W H
2 880122C-1 670 560 38

870120C-1 625 515 38
860118C-1 590 480 38

序号 型号 L W H
9 880322C 575 445 20

870320C 505 365 20
860318C 460 320 20

无柄方形镜面盘

连柄方形镜面盘（镀金）

叠柄方形镜面盘（镀铬）

叠柄方形镜面盘（镀金）

Oblong Tray

Oblong Tray/W.Handles

Oblong Tray/W.Handles

Oblong Tray/W.Handles

无柄椭圆形镜面盘

连柄椭圆形镜面盘（镀金）

叠柄椭圆形镜面盘（镀铬）

叠柄椭圆形镜面盘（镀金）

Oval Plate

Oval Plate/W.Handles

Oval Plate/W.Handles

Oval Plate/W.Handles
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OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

摆
件

系
列

摆
件

系
列

CERAMIC PLATE陶瓷盘（刚质瓷） CERAMIC PLATE陶瓷盘（刚质瓷）

型号 L W H
NC8863-1 400 400 26
NC8863-2 460 460 28

Stripe plate
条纹方盘

型号 D H
NC8865-1 Φ400 22
NC8865-2 Φ480 26

Jewel tracery plate
宝石纹平盘

型号 D H
NC8866-1 Φ400 22
NC8866-2 Φ480 26

Burr plate
凸纹圆盘

型号 L W H
NC8864-1 440 400 26
NC8864-2 530 480 28

Hexagonal plate
六角浅盘

型号 L W H
NC8872 118 88 16

Turtle plate
海龟盘

型号 L W H
NC8873 200 85 33

Ribbon plate
彩带盘

型号 L W H
NC8871 190 110 15

Hippocampal plate
海马盘

型号 L W H
NC8869 167 70 19

Peanut shell bowl
花生碗

型号 L W H
NC8870 178 170 28

Starfish plate
海星盘

型号 L W H
NC8868 90 90 45

Barley bucket blow
麦斗碗

型号 L W H
NC8874 95 85 7.5

Shell plate
贝壳盘

型号 L W H
NC8867 95 90 45

Tripod blow
三足鼎碗
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OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

摆
件

系
列

摆
件

系
列

GLASS(GLASS MELTING) 玻璃（熔制玻璃）

型号 L W H
NC8867 445 445 8

NF114
玻璃盘

型号 W H
NSG126 Φ500 6

型号 W H
NA131 Φ400 6

型号 W H
NA131  Φ380 6

NSG126
玻璃盘

NA113
玻璃盘

NA131
玻璃盘

型号 L W H
NC104 390 390 6

NC104
玻璃盘

型号 L W H
NG152 420 420 8

NG152
玻璃盘

型号 L W H
NC137 350 350 6

NC137
玻璃盘

型号 L W H
A1104-1 420 130 470

Oval Food Frame Oval Food Frame
椭圆形食物展示架 椭圆形食物展示架

型号 L W H
A1104-2 720 225 630

型号 L W H
A1105 300 200 525

Champange bucket
香槟桶

型号 L W H
A1106-1 200 200 40
A1106-2 300 300 40
A1106-3 400 400 60
A1106-4 500 500 60

Showcase Tray

A1103

瓦形展示架

不锈钢水果篮
> Fruit Basket

SD2511
带电透明半翻盖宴会餐炉

CINNABAR SERIES（系列）

> Pine ornaments

> Pine ornaments

W3008

W3016

摆件

摆件

> Pine ornaments

W3012
摆件
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OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

保
温

灯
系

列

摆
件

系
列

S17501 S17502
组合展示架 组合展示架 ( 中间扇形摆件为玻璃 ) 

> L:610  W:440  H:680 > L:610  W:440  H:680

HEATING  LAMPS/SINGLE

HEATING  LAMPS/DOUBLE

单头多功能食物保温灯

双头多功能食物保温灯

额定功率 额定电压 额定频率
1200W 220-240V~ 50/60HZ 适用 10A 国际插头

额定功率 额定电压 额定频率
1200W 220-240V~ 50/60HZ 适用 10A 国际插头

HL2418 HL2418-2

> L:450  W:440  H:680

额定功率 额定电压 额定频率
250W 220-240V~ 50/60HZ 适用 10A 国际插头

HL1818
HL1818-2

H1005 H1005B H1005D
额定功率 额定电压 额定频率
1200W 220-240V~ 50/60HZ 适用 10A 国际插头

HL1005
HL1005B
HL1005D

W1104-5
三层圆形展示架 

W1104-6
三层展示架 

> Glass Display  Wheels > Glass Display  stand

W1104-3
二层展示架 

W1104-4
三层 U 型展示架 

> Display  stand > Display  stand

G5250
玻璃展示台 

> Serving display

G6300
玻璃展示台 Serving display

> Serving display

> Combination Display 
with steel base

> Combination Display 
   with steel base

G5850
长方形镜台 

G6050
长方形镜台带手柄
> Oblong Mirror Plate 

with handle
> Oblong Mirror Plate
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OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

保
温

柜
系

列

保
温

灯
系

列

HEATING  LAMPS/DOUBLE HEATER PROOFER双头多功能食物保温灯 移动保温柜

HP50/HP100

HP1500

> L:635  W:460  H:690

额定功率 额定电压 额定频率
500W 220-240V~ 50/60HZ 适用 10A 国际插头

KHL2518
HL2518  /  HL2518-2

> L:610  W:410  H:680

额定功率 额定电压 额定频率
500W 220-240V~ 50/60HZ 适用 10A 国际插头

HL2418R

> L:1020  W:500  H:730

额定功率 额定电压 额定频率
600W 220-240V~ 50/60HZ 适用 10A 国际插头

额定功率 额定电压 额定频率
500W 220-240V~ 50/60HZ 适用 10A 国际插头

HL4020-2 

HL4020 

> L:1020  W:500  H:730

额定功率 额定电压 额定频率
500W 220-240V~ 50/60HZ 适用 10A 国际插头

HL4030/HL4030-2

额定功率 额定电压 额定频率
1500W 220-240V~ 50/60HZ 适用 10A 国际插头

名称 L W H
餐盘 660mm 458mm 25mm

名称 L W H
餐盒 320mm 220mm 45mm

额定功率 额定电压 额定频率
1500W 220-240V~ 50/60HZ 适用 10A 国际插头

CB-4

PTA-1

餐盒

餐盘

KHL2518
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OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

暖
碟

机

暖
碟

机

型号 额定功率 额定电压 额定频率
WD19001 380W 220-240V~ 50/60HZ 适用 10A 国际插头

型号 额定功率 额定电压 额定频率
WD19002 380W 220-240V~ 50/60HZ 适用 10A 国际插头

每头可容纳 70 至 100 个瓷盘，
适用于15-30厘米直径的瓷盘，
瓷盘承受力可有折半弹簧自行
调节。

> Dual-head dish warmer

WD19002
双头暖碟机

> Single dish warmer

每头可容纳 70 至 100 个瓷盘，
适用于15-30厘米直径的瓷盘，
瓷盘承受力可有折半弹簧自行
调节。

WD19001
单头暖碟机
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OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

不
锈

钢
份

数
盘

系
列

不
锈

钢
份

数
盘

系
列

Standard Anti-jamming GN Pans(Steam Table Pans)

NEW STANDARD NEW DESIGN

NEW ANTI-JAMMING GN PANS
 (STEAM TABLE PANS)

新标准 新内涵 全新设计

A 款不锈钢份数盘（食物盘）

高强度、抗撞击、随意叠放、取用自如。

STACKABLE AND NESTABLE 
RECEPTACLES PATENT.

已在中国、美国、日本获得专利。

WE HAVE GOT THE PATENT OF DESIGN IN 
CHINA, AMERICA, JAPAN.

New Anti-jamming GN Pans (Steam Table Pans)
A 款不锈钢份数盘（食物盘）

B 款不锈钢份数盘（食物盘）

边缘被加固，抗碰撞，不易变形。

Strength designed in the rim.
Resistance touch. Keep the style 专利设计，随意叠放，不黏连，盘

内不积水。 带孔盖、便于放置长柄勺。

光滑表面处理，美观实用。

Stackable and Nestable Receptacles 
patent put and down easy. Slotted lid could put ladle 

inside.

Electric polish in surface. 
Looks very fine and smooth.

便于倒水的水槽设计。

Special slot for put out water.

> 530mmX652mm

> 530mmX327mm

> 265mmX327mm

2/1 size pans

1/1 size pans

1/2 size pans

2/1 尺寸

1/1 尺寸

1/2 尺寸
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OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

不
锈

钢
份

数
盘

系
列

不
锈

钢
份

数
盘

系
列

> 530mmX163mm

> 353mmX327mm

> 176mmX327mm

> 265mmX163mm

> 176mmX163mm

> 176mmX109mm

2/4 size pans

2/3 size pans

1/3 size pans

1/4 size pans

1/6 size pans

1/9 size pans

2/4 尺寸

2/3 尺寸

1/3 尺寸

1/4 尺寸

1/6 尺寸

1/9 尺寸

Perforated pans

Standard Covers

冲孔盘

份数盘盖
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OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

不
锈

钢
份

数
盘

系
列

不
锈

钢
份

数
盘

系
列

NEW ANTI-JAMMING GN PANS
 (STEAM TABLE PANS)
B 款不锈钢份数盘（食物盘）

> 530mmX327mm

1/1 size pans
1/1 尺寸

> 265mmX327mm

1/2 size pans
1/2 尺寸

> 530mmX163mm

2/4 size pans
2/4 尺寸

> 353mmX327mm

2/3 size pans
2/3 尺寸

> 176mmX327mm

1/3 size pans
1/3 尺寸

> 265mmX163mm

1/4 size pans
1/4 尺寸

> 176mmX163mm

1/6 size pans
1/6 尺寸

> 176mmX109mm

1/9 size pans
1/9 尺寸

Perforated pans
冲孔盘

Standard Covers
份数盘盖



147 | Achieve every quality dining experience Achieve every quality dining experience | 148

OTHER SERIES  其
他
类

OTHER SERIES  其
他
类

彩
色

份
数

盘
系

列

彩
色

份
数

盘
系

列

COLOR STEAM TABLE PAN SERIES STEAM TABLE PAN SERIES（彩色份数盘系列） （份数盘系列）

> GN pan 1/1*65mm*304*0.8mm
with polished rim

> GN pan 1/2*65mm*304*0.8mm
with polished rim

P11065 P12065
抛口份数盆 抛口份数盆

> Round 38cm ss food pan
>304*0.8mm with polished rim

> Round 38cm ss food pan
>304*1.0mm with polished rim

P6008 P6008H
抛口圆食物盘 抛口圆食物盘

> Round 38cm ss food pan
>304*0.8mm with polished rim

> Round 38cm ss food pan
>304*0.8mm with polished rim

P6009 P6012
抛口圆双格食物盘 抛口圆食物盘

> GN pan 1/3*65mm*304*1.0mm
with polished rim

> GN pan2/3*65mm*304*1.0mm
with polished rim

P13065H P23065H
抛口份数盆 抛口份数盆

> GN pan 1/3*65mm*304*0.8mm
with polished rim

> GN pan 2/3*65mm*304*0.8mm
with polished rim

P13065 P23065
抛口份数盆 抛口份数盆

> GN pan 1/1*65mm*304*1.0mm
with polished rim

> GN pan 1/2*65mm*304*1.0mm
with polished rim

P11065H P12065H
抛口份数盆 抛口份数盆

> 1/1 food insert with red color
> 0.8mm

> 1/1  Coating Aluminum Pan

> 1/1  Coating Aluminum Pan

> 2/3  Coating Aluminum Pan

> 2/3  Coating Aluminum Pan

11065R

11025AP

11025	AF

23025AP

23025AF

1/1 红色食物盘

1/1 涂层铝盘（蛋形盘）

1/1 涂层铝盘（平盘）

2/3 涂层铝盘（蛋形盘）

2/3 涂层铝盘（平盘）

> 1/1 food insert with Black color
> 0.8mm

> 1/2 food insert with Black color
> 0.8mm

11065B 12065B
1/1 黑色食物盘 1/2 黑色食物盘 0.8mm

> 1/1 food insert with White color
> 0.8mm

> 1/2 food insert with White color
> 0.8mm

11065W 12065W
1/1 白色食物盘 0.8mm 1/2 白色食物盘

> 1/2 food insert with red color
> 0.8mm

12065R
1/2 红色食物盘

型号 尺寸 容量
11025AP 1/1X1''（25mm） 3.5

型号 尺寸 容量
11025AF 1/1X1''（25mm） 3.5

型号 尺寸 容量
20325AP 2/3X1''（25mm） 1.6

型号 尺寸 容量
20325AF 1/2X1''（25mm） 1.6

> 1/1  Coating Aluminum Pan > 2/3  Coating Aluminum Pan

11025	AW 12025AW
1/1 涂层铝盘（波形盘） 2/3 涂层铝盘（波形盘）

型号 尺寸 容量
11025AW 1/1X1''（25mm） 3.5

型号 尺寸 容量
20325AW 1/2X1''（25mm） 1.6
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